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Business Analysis Tools

Enterprise Architect is a sophisticated and flexible Business Analysis modeling tool that can be used by the analyst from
planning through to product support. The tool can be used with any Business Analysis process and there is a wide range
of features that allow analysts to work using their preferred methods, such as Word Processor views, Spreadsheet views,
Diagrams, Relationship Matrix or a number of other core and extended features. The analyst will be happy in the
knowledge that whatever the task is, there will be a tool to assist them to carry out their work, and the results will be
stored in a sophisticated repository that can be accessed by other team members who will ultimately benefit from their

work.

This Mind Map shows the landscape of the key Business Analysis tools that can be used to develop and manage the wide
range of artifacts produced by the Business Analyst.
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Activity Diagram

Getting to know the Activity Diagram

Introducing the Activity The Activity diagram is one of the Unified Modeling Language (UML) Behavioral
Diagram diagrams that can be used to model a process or algorithm as a sequence of steps.
It is a more sophisticated version of its close cousin the Flowchart diagram.
Activity diagrams can be used to model Business Processes as a UML alternative
to the BPMN Business Process diagram and have the same ability to create a
hierarchy of Activities in the Browser window.

Activity Diagram showing the use of Partitions

[Order Rejected]

Valid
i Dder Placed ‘ Oncer?

[Order Accepted]

(%)

This diagram shows the use of Partitions (swim
lanes) to organize the elements and these can be

Package Order

Process
Payment

Send Invoice Setom
payment
Invoice L|:, %‘ Invoice

The elements can be given a name and detailed descriptions can be added to the
notes. By connecting the Activities, Decisions and Forks with connectors (Control
Flows) a sequence of elements can describe the business process. A process
hierarchy can be constructed by nesting Activities in the Browser window and
using the child diagram functionality to enable drill down from the value chain
level to the lowest level processes.

Close Order orientated horizontally or vertically They actasa

container for the elements in the Browser

window. The diagram also shows the use of
Outputand Input pins connected by an Object
flow.

«Cass» Order

«Cass» Transaction

Where to find the Activity Ribbon: Design > Diagram > Add > UML Behavioral > Activity

Diagram Browser window Toolbar : New Diagram icon > UML Behavioral > Activity

Browser window context Menu | Add Diagram... > UML Behavioral > Activity

Usage of the Activity The Activity diagram can be used to model any business or technical activity or
Diagram notion that has a series of steps. This includes business and technical processes
and also computer algorithms. The steps are connected by Control Flow
relationships that show the sequencing of the steps. Decisions and Merges can be
used to model choice and to further control the flow through the Activity. Forks
and Joins can be added to split and reunite the flow of control and objects added to
show how data is supplied and consumed.

Options for the Activity Activity diagrams can be drawn at different levels of formality, from a Basic Flow
Diagram Chart style of diagram used to represent a simple Business Process to a
sophisticated Action-based diagram that can be used to model a complex system.
There is a toolbox that contains a range of elements, relationships and Patterns for
creating the models.

The Activity diagram (like any diagram) can be viewed as an Element List, which
makes working with element properties easier.

Diagram Filters can also be used when presenting the diagrams, to draw attention
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to parts of the diagrams, and the diagrams can be presented in hand drawn or

whiteboard style by changing the properties of the diagram.

Toolbox

E Activity

@eed I UeCEHMUINAN 0 U

= [ @

Activity

Structured Activity
Action

Partition

Ohject

Central Buffer Node
Datastore
Decision

Merge

Send

Receive

Synch

Initial

Final

Flow Final

i Region

Exception
Fork/Jain
Faork/Jain

=l Activity Relationships

A
w
F

Control Flow
Object Flow

Interrupt Flow

=l Activity Patterns

¥

Basic Activity

O =

Maore tools. ..

Fs

Activity Diagram

Page 6 of 153

Created with Enterprise Architect


http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/model_domains/activitydiagram.html

Business Analysis Tools - Business Analysis Tools

Artifact

20 January, 2020

Getting to know the Artifact

Introducing the Artifact

Where to find the Artifact

Usage of the Artifact

(c) Sparx Systems 2019

An Artifact can be used to represent an external file that resides outside the
repository. This is particularly useful for making reference to external file sources
including files such as word processor files, spreadsheets and web pages or files
reachable by a Universal Resource Indicator (URI). They are also used for other
purposes in Enterprise Architect such as for programming source code files and
database Tables.

The external files can be opened by selecting the element in a diagram or the
Browser window and pressing Ctrl+E or the F12 key. Each file is opened either on
a separate tab in the Diagram View workspace (if the file can be opened within
Enterprise Architect) or in the default Windows viewer/editor for the file type (if
the file cannot be opened within Enterprise Architect).

North Americaand European Academic T

Business Analysis tools, Business Case issues in
Sparx Systems Enterprise Architect
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of sk or architecturalsignificance. The
document is modeled using a Document Artifact
and the statements using an Issue element.

e ready for the Commencement of the next
iropean Academic Year. The financial modeling
ks of academic titles into the first year of

n needs to be available for the product entry
s are listed and ready for purchase.

-Online Bookstore

of-print titles L

has been prepared to
lution options and what is

h solution. It recommends
ng the most appropriate for
Italso lista number of
which are considered to be
sful result. It was written to
rd for the purpose of

for this strategic project

ervice and is expected to produce good return
are some titles that sell for tens of thousands of
ers are specialized and must be treated

de gallery owners, national libraries, and

ulnerability dueto online presence L

presence has caused the security architect
vulnerability of systems and the information
force is now global and this requires new
nsitive information that must be accessed by
otentially un-trusted networks.

Toolbox Page: Common, Artifacts, Component, Documentation, Deployment |
Artifact

The Artifact is a powerful tool for connecting elements in the repository with
external files or web resources. It is particularly useful when a file such as a
spreadsheet, word processor, presentation or other file that resides outside the
repository has to be referenced or connected to elements inside the repository. For
example, a Business Case might have been written before the Enterprise Architect
repository was established, in a word processor file stored in a corporate document
registry available through a URL.

The file can simply be dragged onto any Enterprise Architect diagram, which will
give the user the option to create an Artifact representing the external document.
Leaving the default name will assign the name of the external file. A hyperlink
will be created automatically. The Artifact in the repository acts as a surrogate,
and any number of elements can be connected to it or Tagged Values added to it.
The external file can be opened by simply selecting <Ctrl> <E> or <F12> or by
using the 'Launch’ option of the Artifact 'Properties' dialog.

The Artifact can be used to create references to project management documents or
resources that are located in a Project Management Office registry.

It is also useful to create a virtual reference library inside Enterprise Architect,
connecting to resources that reside outside the repository.
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Options for the Artifact

Learn more about the
Artifact

(c) Sparx Systems 2019

The Artifact can be created as an External or an Internal file. When a file or
resource is dragged onto a diagram, a menu will prompt the user to select the type
of Artifact to create:

'Hyperlink' creates a Hyperlink element on the diagram; you can select a
sub-option to define what happens when double-clicking on the Hyperlink -
'Open' displays the file content and 'Edit' opens it within the assigned file
editor

'Artifact (External)' creates an Artifact element on the diagram that stores a
hyperlink to the external file; press F12 or Ctrl+E to open the external file

'Artifact (Internal)' creates an Artifact element on the diagram and makes a
copy of the file inside the repository; double-clicking the Artifact launches the
internal document

'Image Asset' (graphics files only) creates an Image element in the model
repository - the element is created in the Package that contains the diagram
and it is displayed on the diagram; Image elements can be displayed on a
diagram as the image itself, or as a simple element representation

'Insert' (graphics files only) inserts the file into the diagram as a filled
Boundary element

Hyperlink 4
Artifact (External]

Artifact (Internal)

Image Asset

Insert

Artifact
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Getting to know Auditing

Introducing Auditing

Where to find Auditing

Use of Auditing

Options for Auditing
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The Auditing feature can keep track of the changes to Requirements including
what was changed, when it was changed and by whom. Auditing is by default
disabled and must be enabled before the changes to requirements will be recorded.
Once enabled it is a passive tool that silently records the changes to elements. It
does not replace Version Control or Baselines and in contrast to these tools it can
not be used to return to a previous state of the model. Change management,
governance and quality control are all aided by the use of Auditing.

Audit View x 4 b
User  Greg Michols Load Sort By
Time  2015-05-13 10:39:13 @ Type
Cetgile Requirement, (REQO15 - Process Audit Settings | | Search (7 User
Credit Card Payments)
Mode - Help
] Audit Settings Property Original Change
__| Requirement Elements status Validated Implemented

= REQO15 - Process Credit Card Payments
p-} 2015-05-13 10:39: 13
;,f' 2015-05-13 10:39:13

Ribbon: Configure > Model > Auditing

Auditing can be used to track what was changed in a model, who changed it and
when. There are a number of modes and a repository administrator can use the
settings to specify what is recorded in the audit. While a baseline can be used to
show the difference between a model and a snapshot at a point in time, the
Auditing tool records each individual change; it can not, however, be used to
revert to a previous state.

There is a wide range of settings to configure auditing, starting with enabling or
disabling the settings that determine which elements have an audit trail and the
level of detail recorded. Audit logs can be exported from the repository to increase
performance.
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Enable Audting [~ Audting Level
&) Care
[C1] Awdit XMI Impart i@ Standard
[ Audit XMI Expott | ) Extended
u .Pu.ld:rt Ea'frerse
Engineering Sudit Options
lze Databaze
Timestamp () Maintenance
{1 Core Structural
Clear Logs i@ Al
{0 Cust
Save Logs : o
Customize
Load Logs
QK Cancel Help

Learn more about Auditing
Auditing
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Auto Names and Counters

Getting to know Auto Names and Counters

Introducing Auto Names
and Counters

Where to find Auto Names
and Counters

Usage of Auto Names and
Counters

Options for Auto Names
and Counters

Learn more about Auto
Names and Counters

(c) Sparx Systems 2019

To aid, regulate and enforce a naming standard, Enterprise Architect includes
some capabilities to configure the default names assigned to new elements of a
specific type. This is a useful feature when dealing with complex and large sets of
requirements, but is also relevant when dealing with smaller data sets. Auto
Names and Counters can be used to assign a sequential number to any element
type including Requirements. It includes a prefix definition, a counter and a suffix
definition allowing numbers such as: 'REQO007 - Manage Inventory' to be created.

Requirement -
Close

MName
Prefic Counter Sufioc

REQ 001 i Ponly on

Alias
Prefix Counter Sufig

Apply on
D creation Help

Ribbon: Configure > Reference Data > Settings > Auto Names and Counters

Analysts and others can use the sequential number for communicating
unambiguously about the requirements without having to use the often long
requirement name. Select the 'Apply on Creation' option to start using the auto
numbering feature; this can also be used to temporarily suspend auto naming, for
example if other types of requirements are being entered that don't need to have
sequential numbers assigned.

There are options to define the prefix, counter and suffix for a requirement.

Type
Requirement -
MName
Prefix Courter Suffoe
REQ 0001 : ILIT
Alias
Prefic Courter Suffoe
Apply on
D creation

Apply Auto Naming to Existing Elements
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Balanced Scorecard

Getting to know the Balanced Scorecard

Introducing the Balanced
Scorecard

Where to find the
Balanced Scorecard

Usage of the Balanced
Scorecard

(c) Sparx Systems 2019

Balanced Scorecard is a strategic diagram that allows a balanced approach to
performance measures to be modeled. The diagram can be created from a Pattern
that adds and connects the four perspectives: Financial, Customer, Internal
Business Process, Learning and Growth. Most organizations of any appreciable
size will be using some type of Balanced Scorecard approach to align business
activities to the vision and strategy of the organization, to monitor performance
against strategic goals and to improve communication. The Balanced Scorecard
diagram is part of a set of strategic diagrams that allow many aspects of an
organization's business to be modeled.

Financial Perspective

How should we appear to our shareholders?

- Broaden Revenue Base
- Improve Operating Efficiency
- Reduce Reliance of Domestic Customers

Business Process Perspective Customer Perspective

What Business Processes must we excel at? How should we appear to our Customers?

- Move to Intemet Channel - Product Range

- Reduce Processing Time VISION - Service Excellence
- Broaden Product Offering & - Innovative and Reliable
- Understand Customer Segments STRATEGY - Trusted Business Partner

Learning & Growth Perspective

How can we maintain our ability to change and
improve?

- Increase Employee Productivity
- Hire Internet Aware Technical Staff
- Hire multi-Channel Sales Executives

- Increase Employee Job Satisfaction O

The Balanced Scorecard
diagram is part of the Strategic
Diagrams used by managers
and others to manage activities
performed by the staff under
their control.

Ribbon: Design > Diagram > Add > Strategic Modeling > Balanced Scorecard

Browser window Toolbar : New Diagram icon > Strategic Modeling > Balanced
Scorecard

Browser window context menu | Add Diagram... > Strategic Modeling > Balanced
Scorecard

A Balanced Scorecard can be used to ensure business activities are aligned to the
vision and strategy of the organization, to monitor performance against strategic
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goals and to improve communication.

The Classes representing the four Perspectives can be traced to other elements in
the models, such as Goals and Business Capabilities, and also to Linked
Documents that allow the Perspectives to be documented.

Options for the Balanced
Scorecard

O

Maore tools. ..

Toolbox

k| X

[ Balanced Scorecard
E Perspective
= Patterns

¥ Balanced Scorecard -

Learn more about the Balanced Scorecard
Balanced Scorecard
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Baseline Tool

Getting to Know the Baseline Tool

Introducing the Baseline
Tool

Where to find the Baseline
Tool

Usage of the Baseline Tool

Options for the Baseline
Tool

(c) Sparx Systems 2019

The Baseline Tool can capture a snapshot of the Requirements at a point in time
and then, at a later time, the repository can be compared to this (or another
baseline) for the purpose of determining what has changed. Any number of
baselines can be created and labeled, and there is a baseline comparison tool that
displays the differences between the baseline and the model and allows the
modeler to revert a change in the model to a baseline at a granular level.

Comparing package Manage Inventory against baseline version 3.2
£r Baseline Comparison X
Yoedt R ERBETO
Model Elements Status

= |_] Manage Inventory
- «Functional» REQ019 - Manage Inventony

-1 E Links
=1 /' Realization
IIT Target: («Functional» REQ015 - Manage Invertony) Changed
wFunctionaly REGD20 - Receive tems Changed
wFunctional» REQD21 - List Stock Levels Changed

Ribbon: Design > Model > Manage > Manage Baselines
Keyboard: Ctrl+Alt+B

Baselines are also useful when a formal requirements process is being followed or
the Requirements form part of a contact, as the baseline can keep a snapshot of the
requirements at important milestones such as contract signing or requirement
phase sign off. This is also applicable to iterative and incremental processes such
as Agile methods, as the requirements can be baselined before or even after a
Sprint. When Requirements are still volatile and the Requirements' owners are still
formulating their needs, a baseline can be created to take a snapshot at important
points in the analysis phase, such as after an elicitation workshop.

There are several options that can be applied to configure the way the Baseline
Compare tool presents information; these are available from the Options button on
the Baselines window.
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[[1] Always Expand to Differences

Show Elements that are: Suppress these Changes

Changed [1] Suppress Diagrams

In Baseline Onhy [¥] Suppress Date Modffied

In Madel Onby Suppress Date Created

[ Unchanged tems [[1] Suppress Children of Missing tems

Suppress Advanced Properties

Baseline Diagram Compare Options

[ Away= open first parert with a Baseline
- When comparing from the Project Browser or a Diagram

Learn more about the Package Baselines
Baseline Tool
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Boundary

Getting to know the Boundary

Introducing the Boundary The Boundary element is derived from the Use Case system boundary but can be
used extensively in other contexts as a way of describing a separation between a
system or part of a system and its external environment. Any number of
Boundaries can be added to a diagram and other elements such as Use Cases,
Features, Requirements, Components and more can be placed inside the boundary.
The properties of the Boundary can be altered to show a number of compartments
organized into vertical and horizontal swimlanes. The border style and opacity of
the Boundary can also be set.
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Where to find the
Boundary

Usage of the Boundary

Stakeholder Onion Diagram

Aff ected External Stakeholders

ing Partner

Organization or Enterprise

Aff ected Organizational Unit

Business Analysis tools, nested boundaries in Sparx
Systems Enterprise Architect

This diagram indicates the level of involvement the
stakeholders have with the solution, which
stakeholders will interact directly with the solution or
participate in a business process, which are part of the
whole organization, and which are outside the
organization.

UML Elements Toolbar | Boundary

Common Toolbox Page | Boundary

The Boundary element is particularly useful for defining what is inside a system
(or part of a system) and what is outside. It can be used to show the Use Cases of a
system or subsystem, the in-scope Features or Requirements. Diagrams created for
management and non-technical audiences will benefit from the use of Boundaries,
which can be colored and nested to have visual appeal and business meaning. It is
essentially a diagrammatic device and does not appear in the Browser window. If a
formal and structural grouping of elements is needed, the modeler could consider

(c) Sparx Systems 2019
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the use of a Package.

Options for the Boundary The Boundary can be configured to have a number of vertical and horizontal
swimlanes, which are useful for grouping elements into different sections of the
boundary, creating a matrix effect. The Border Style can also be configured to
allow different line styles that can then be colored using the standard element
appearance settings. Also, choosing the 'Solid' options allows the Boundary's fill
color to be set.

Boundary Properties X

MName: oK

Online Book Store In-Scope Features|
Cancel
Border Style

i1 Solid
) Dotted Vertical Swim Lanes: 1

i1 Dashed
i@ Solid-Mo Fill

Horizortal Swim Lanes: |1

Help

Learn more about the Boundary
Boundary

(c) Sparx Systems 2019 Page 19 of 153 Created with Enterprise Architect


http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/model_domains/systemboundary.html

Business Analysis Tools - Business Analysis Tools 20 January, 2020

Browser window

Getting to know the Browser window

Introducing the Browser The Browser window is the primary tool for structuring and navigating through
window the repository using expanding and collapsing tree nodes. The key structural

element is the Package, which is a folder-like element that can contain other
elements and diagrams, and other Packages. The elements in turn can contain
other elements, features and diagrams. Root nodes are the highest nodes in the tree
and these root Packages can contain views that in turn can contain any level of
Packages and elements. Tree nodes including Packages, elements, Features and
diagrams can be copied and pasted between locations or dragged and dropped to
new locations. Many important tools, functions and windows are applied at the
level of the Package, such as import or export of model content, documentation
and Package Control, including Baselines.
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Where to find the Browser
window

Usage of the Browser
window

'Bruwser O x
e+t 8 =- b

Project| Context Diagram Element

4 £ Online Book Store Project —
4 O Management
[ 7 Contracts
[+ 1 Information
> £ Risk Analysis
4 £ Context
[ 7 References
[+ 1 Business Model Canvas
[» £ Document Analysis
[+ 1 Stakeholders
[» £ Strategy
4 £ Problem
[ 7 Current State
[+ 1 Goals
> £1 Objectives
I [+ £ Measures
4 £ Features
T2 Feature Hierarchy
T2 Features in Scope
[ «Functional= FEAD18 - Market Management
O «Functional= FEAD19 - Human Resources System
[ «Functional= FEAD20 - Item Management
4 [ «Functional= FEADD1 - Inventory Management
[ «Functional= FEADOT - Transfer Management
[ «Functional» FEADOS - Threshold and Level Cc
[ «Functional= FEADODY - Supplier Integration
[ [ «Functional= FEAQDZ2 - Distribution Management
f> [ «Functional= FEADD3 - Platform Management
I [ «Functional= FEADD4 - Customer Relationship Ma
4 £ Business Requirements
(3 Business Use Cases
b 3 Customer Relationship Management
[ 7 Evaluation Criteria
£ Regulatory Requirements
[» (7 Stakeholder Requirements
[ 7 Solution
| I £ Transition -

Ribbon: Explore > Portals > Windows > Explore > Project Browser
Ribbon: Start > Desktop > Design > Browser

The Browser window can be used to create and manage the structure of the
repository by adding and deleting, moving and copying Packages, elements,

(c) Sparx Systems 2019
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Options for the Browser
window

Learn more about the
Browser Window

(c) Sparx Systems 2019

Features and diagrams. It is often the primary tool for exploring and browsing
through the elements in the repository and finding things of interest. A modeler
working with an open diagram will often want to locate a diagram object in the
Browser window as a way of finding out what Package it belongs to and what its
peers are.

The Browser window has a context menu that contains the important functions
that apply to each of the selected element types. Many of the functions are also
available in the Browser header bar, including the ability to create models,
Packages, diagrams, elements and documentation, and the ability to focus on
specific Packages in the model by identifyingthem as 'Favorites'. The Browser
window itself can be moved around the workspace as required.

e S

There are also several important ways the Browser window can be configured by
using the Preferences' dialog. These include the ability to show or hide stereotypes
in the name of a tree node, the ability to freely sort the tree nodes within a Package
or element and whether to warn about deletions from the tree.

-

Browser Window
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Business Process Diagram

Getting to know the Business Process Diagram

Introducing the Business The Business Process diagram is part of the Business Process Model and Notation
Process Diagram (BPMN) and is the main diagram type for defining business processes. The
diagram can include Start, Intermediate and End Events, Business Processes,
Activities, Gateways, Pools and Lanes, and more. The elements can be given a
name and detailed descriptions can be added to the notes. By connecting the flow
objects with connectors, a sequence of activities, gateways and events can describe
the business process.

A process hierarchy can be constructed by nesting Business Processes and
Activities in the Browser window and using the child diagram functionality to
enable drill down from the value chain level down to the lowest level processes.

Where to find the Business Ribbon: Design > Diagram > Add > BPMN x.y > Business Process

Process Diagram Browser window Toolbar : New Diagram icon > BPMN x.y > Business Process

Browser window context menu | Add Diagram... > BPMN x.y > Business Process

Usage of the Business Business Process diagrams can be used to model the Business Processes in an
Process Diagram entire organization or part of an organization. Business Processes can be created to
represent the current or future state of the organization at any level of detail from
the value chain down to a process performer level. A process hierarchy would
typically be defined that would set the standards for the number of levels, naming,
organization of the processes and more.

Options for the Business Business Process diagrams can be drawn at different levels of formality, from a
Process Diagram Basic Flow Chart style of diagram used to represent a simple Business Process to a
sophisticated diagram making use of many of the markers for Events and
Activities to describe complex business processes. There is a toolbox that contains
a range of elements, relationships and Patterns for creating the models.
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Toolbox O
Maore tools...
= BPMHMN 2.0 - Business Process
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The Business Process diagram can also be used to generate Business Process
Execution Language (BPEL), which is an XML language that can be ingested by a

number of tools.

The Business Process diagram (like any diagram) can be viewed as an Element
List, which makes working with element properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention

to parts of the diagrams.

Business Process Diagram
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Business Process Simulation

Getting to know Business Process Simulation

Introducing Business
Process Simulation

Where to find Business
Process Simulation

Usage of Business Process
Simulation

Options for Business
Process Simulation

Learn more about

(c) Sparx Systems 2019

The BPSim facility provides a way of simulating processes written in Business
Process Model and Notation (BPMN), providing valuable results that can be used
in process analysis. The BPMN models are augmented with extra data as
parameters to the simulation. It allows structural and capacity analysis to be
performed, providing for pre- and post-execution optimization. Enterprise
Architect allows you to construct the Business Process Models and enter the
appropriate data, which is then sent to a BPSim Simulation engine.

Initisl Estimate Accepted —

Payment

Customer Leaves Shop

Make Estimate

Customer Arrives

Initial Estimate: Not
Accepted

Scenario 1: Main flow
=-H P @

Select/Create Artifact:
Scenario 1. Main flow

Scenario | Calendars Properties Trigger Count Review

Select Package: Parameters Value

Car Repair Process } Start 22/06/2016 9:00 AM
e Duration 0000 007:59:00
<All> . Tirne Unit
Cost Unit
- Replication 1
- Calendars
- Properties eed u
- Trigger Count Created 14/12/2015 3:49:36 P
- Activity WMadified 15/01/2016 9:35:55 AM
[t BusinessProcess Expression Language *Path 1.0
[ EndEvent
[l- Gateway JRE Home C:\Program Files (x86)\Java\jre?
[ StartEvent |DK Home C:\Program Files (x86)Yavaydk1.7.0
Part 1799

You can purchase and download the MDG BPSim Execution Engine from the
'"Products' page of the Sparx Systems web site.

Business Process Simulation is essentially used to mimic real world or planned
processes in a model, providing a low cost way of determining the effectiveness or
value of a Business Process. An analyst can assign operating information to a
model and then assess the quality or effectiveness of the solution based on
information received back from the Simulation engine. Simulations can be run any
number of times adjusting configuration information. The Simulation can be
performed on current state and future state processes as required. It is common
practice only to investigate critical or problematic processes.

The configurations created inside the repository and the BPMN Business Process
diagrams can be exported in a standard format and consumed by any standards
compliant BPSim engine. Sparx Systems sells a BPSim Compliant simulator
available in the MDG BPSim Execution Engine that allows the simulation to be
performed inside the tool.

Simulation results can be stored in the engine and used for cross simulation
comparison.

Business Process Simulation
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Business Process
Simulation
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Business Rules Model

Getting to know the Business Rule Model

Introducing the Business The Business Rules Model provides a way of formally defining business rules,
Rule Model including the way they are sequenced and the domain elements they relate to. The
model allows Business Rules to be formally represented in a way that prepares for
the automatic generation of application (programming) code that would ultimately
be used to implement the rules. There are three main parts to the notation for
documenting the rules:

1. The Business Rules that express a Policy and are applicable to a Business
Process.

2. The Business Rule Tasks that express a task or decision that the business
processes must make.

3. The domain or information elements that represent the vocabulary or facts
that the Business Rules relate to.

The Business Rules can also be related to Policies (from which they derive),
Requirements (which they realize) and the application services that implement

them.
=
T
|
|
|
|
|
|
mestic Shipping rate £ | uleTask»
ivery is USD30.00 | — — — — +--= Domestic Shipping
| Rate
|
|
|
|
|
mestic Shipping E | O
days deliveryis ~  pF———— -
Business Analysis tool, Rule
Model diagram in Sparx

Systems Enterprise Architect
Business Rules are defined using
the Business Rule element in the
Rule Model toolbox. Rules for
each specific purpose are
grouped together with their
respective Rule Task elements
using Dependency relationships.

Where to find the Business Ribbon: Design > Diagram > Add > Business Rule Model > Rule Flow, Rule
Rule Model Model

Browser window Toolbar : New Diagram icon > Business Rule Model > Rule
Flow, Rule Model

Browser window context menu | Add Diagram... > Business Rules Model > Rule
Flow, Rule Model

Usage of the Business Rule The Business Rules Model can be used to formally model business rules and the
Model way they are applied in a rule task. The model provides a useful way of structuring
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the rules as a group, by connecting them to a Rule Task that can be related to the
Business Process where the rules are being applied. This has the effect of reducing
the clutter on a Business Process diagram and showing how the Business Rules
apply as a set. The important information elements and facts can also be related to

the Rule Tasks, again reducing the clutter of connecting individual domain
elements with specific rules.

Options for the Business The Business Rules and the Rule Tasks can be related to Policies, Requirements,

Rule Model Business Processes and other model elements creating an articulated model that
shows how the business rules are applied.

Behavioral models can also be generated from the Business Rules Models.

Toolbox O =

Mare toals ...

| £l Rule Model

B9 Business Rules Model

B8 Business Rules Package
B9 Business Domain Model
Business Rule

2 Rule Task

| = Rule Model Relationships

1 Dependency

Learn more about the Business Rule Model
Business Rule Model
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Calendar

Getting to know the Calendar

Introducing the Calendar The Calendar is a fully featured mechanism for recording the important events in
an initiative and displaying other information such as resource allocation. There
are day, week and month views and the display can be set to show Calendar
entries, Project Tasks and Resource Allocation. When a resource has been
allocated - for example to analyze a set of requirements - a user can drill through
from the Calendar to the requirements' location in the Browser window.
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3 Technical Revie "2.- Weekly Stac
g 7% Fortnight B

5228 29 30 531

23- 28

January 2016
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There are also fully configurable Event Types, Categories and colors. The work of
a Business Analyst will involve a wide range of events including things like:
workshops, interviews, focus groups, collaborative games, brainstorming sessions,
reviews, observations and meetings. All of these events can be conveniently
recorded and managed in the Calendar. When resources have been allocated to
elements and tasks have been assigned to individuals these can be displayed in the
Calendar.

Where to find the Ribbon: Start > Collaborate > Calendar
Calendar

Usage of the Calendar The Calendar can be used to schedule and view events such as meetings,
milestones, reviews, workshops and more. It can be used to view the allocation of
resources to elements in the repository such as who is analyzing a set of
requirements. It can also be used to view Project Tasks. An analyst can
conveniently click through to the elements in the Browser window or the Project
Tasks.

Options for the Calendar The Calendar has a number of options including the ability to create recurrent
events. There is an options toolbar icon that allows aspects of the Calendar's
appearance to be configured.
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Learn more about the Calendar
Calendar
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Class Diagram

Getting to know the Class Diagram

Introducing the Class The Class diagram is one of the Unified Modeling Language (UML) Structural
Diagram diagrams that can be used to model a wide range of things. It is a general purpose
diagram for modeling entities in the business and technical domains, including
terms and concepts, Business Rules, and Capabilities in XML and Database
Schemas.

Catalog Line Item

Cart Item

Publisher

+billingl___+shippinet

This diagram

Author Address Account

shows how a

class diagram

can be used to

Lapd create a

Reader Review| D Item Elements conceptual
D Ovder Elements
D Cart Elements model that

describes and

relates the
business
vocabulary.
The elements
have notes
describing
their purpose
and
associations
relationships
and
multiplicities
describe how
they relate to
other business

terms.

Where to find the Class Ribbon: Design > Diagram > Add > UML Structural > Class
Diagram Browser window Toolbar : New Diagram icon > UML Structural > Class

Browser window context menu | Add Diagram... > UML Structural > Class
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The Class diagram can be used whenever a logical or structural representation of a
system is required. It has applicability for modeling both business and technical
concepts and can be used to model information and structures such as XML and
database schemas.

The Class diagram (like any diagram) can be viewed as an Element List, which

makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention
to parts of the diagrams and the diagrams can be presented as hand drawn or in a
whiteboard style by changing the properties of the diagram.

Toolbox
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Class Diagram
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Component Diagram

Getting to know the Component Diagram

Introducing the
Component Diagram

Where to find the
Component Diagram

Usage of the Component
Diagram

Options for the
Component Diagram

The Component diagram is one of the Unified Modeling Language Structural
diagrams that can be used to model the logical components that make up a system.
They can be used to model the applications of an organization including their
Provided and Required Interfaces and the information that is exchanged between
the interfaces.

Sales Data

<-TEUR O

«flow»
Entity Entity
Financial Financial

nterface»
ity Financial
{abstract}

This Component Diagram shows the use of
Ports and Provided and Required Interfaces
and Information Flows to show what
information flows between two Enterprise
Systems at an Architectural Building Block
Level.

sValue(int, int): int

Component hierarchies can be created that show how top levels systems or
applications are broken down to lower level Components. The Components can be
given a name, detailed descriptions can be added and additional properties can be
added using Tagged Values.

Ribbon: Design > Diagram > Add> UML Structural > Component
Browser window Toolbar : New Diagram icon > UML Structural > Component

Browser window context menu | Add Diagram... > UML Structural > Component

The Component diagram can be used to model logical or physical parts of a
system including current and future state Components. Application Architectures
often use a number of Component diagrams to describe the architecture of the
applications and how they interact. The interaction between the applications can
be shown using a combination of Ports and Provided or Required Interfaces that
describe how the Components are wired together.

Component diagrams can be drawn at a number of levels of formality, from simple
diagrams that show the dependencies between Components to sophisticated
diagrams using Ports, Interfaces and Information flows.
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4

There is a toolbox that contains a range of elements, relationships and Patterns for
creating Component diagrams.

The Component diagram (like any diagram) can be viewed as an element list that
makes working with element properties easier.

Diagram Filters can also be used when presenting the diagrams, to draw attention
to parts of the diagrams, and the diagrams can be presented in hand drawn or
whiteboard style by changing the properties of the diagram.

Component Diagram
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Dashboard Diagrams

This diagram is an example of creating Dashboard Diagrams in Sparx Systems Enterprise Architect. The Dashboard
Diagrams allow high quality charts and graphs to be created to display repository information in a visually compelling
way, such as the ratio of Requirement Priorities in a pie chart.

Getting to Know the Dashboard Diagrams

Introducing Dashboard
Diagrams

Where to find Dashboard
Diagrams

Usage of Dashboard
Diagrams

Options for Dashboard
Diagrams

(c) Sparx Systems 2019

The Dashboard diagrams allow high quality charts and graphs to be created to
display repository information in a visually compelling way, such as the ratio of
Requirement Priorities in a pie chart. There is a toolbox page of pre-configured
charts and graphs, but the user is free to create and save any number of charts
sourcing data from anywhere in the repository. The charts and graphs provide
valuable summary information that assists in the management of requirements.
High level reporting and project status can be easily tracked and documented using
the numerous charts and report elements available that tightly link in with the
model content and status.

Q

This diagram shows a Pie Chart element
depicting element priority for all the
requirements in a selected package.

It provides a useful summary for a
requirements manager and is
dynamically updated when the Priority
changes and the diagram is reopened.
There are a range of other pre-defined
charts and user defined charts can also
be added. A filter has been added to
exclude all elements other than
Requirements.

Elements by Priority

No Value, 3.6%
High, 17.9%

Medium, 53.6% Low, 25.0%

Browser window | Right-click on Package | Add Diagram : = | Manage | Show
All Perspectives | Extended | Dashboard

Dashboard diagrams present compelling views of information - such as the status
of Requirements in a particular release of the system - that can be viewed inside
the model or conveniently copied directly into management or project team
presentations. They are useful for planning an iteration such as an Agile sprint to
view how ready the Requirements are for the implementation team; for example to
view what percentage of the Requirements have been approved and are of high
priority.

The Standard Charts and Graphs available from the Toolbox can be configured in
a number of ways, including changing the source, applying filters or modifying the
appearance of the chart as indicated in this diagram, available from the chart's
Properties window using the 'Appearance' section.
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Category: Doughnut 30 - Label Position: | Outside End -
Gradient: Radial - Show Data Labels

Hole Size: m 21%
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Fit Diagram Area
Display Legend

Learn more about e  Charts
Dashboard Diagrams
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Data Flow Diagram

Getting to know the Data Flow Diagram

Introducing the Data Flow The Data Flow diagram (DFD) is part of the Structured Systems Analysis and
Diagram Design Method and is used to show the way that data flows through a system
including the Processes, Data Stores and Entities that relate to the data.

Order

\nfcrmaﬁcn—\‘

Order Data Store

Order

Receive
Order Information
A/ Order
Order Yalidate .
Information
Process
Order

Order

Customer Customer Profile \Custcmer
Preferences.

Notification _)—\
Emall Address Address
Send
ptification
Ship
Order
Ordered

Items and\_/
Bonuses-

Ordered
Titles

Inventory

mgem This is a Data Flow Diagram that shows the
. Customer Profile Data way that information (or data) flows through
an organization. The modeler has chosen to
. RicebEt: use color to make it easier to see the data
. Inventory Data sources and where the data flows to.

A hierarch of diagrams is typically created that start from the Context diagram,
which is said to be at 'level 0' in the hierarchy.

Where to find the Data Ribbon: Design > Diagram > Add > Data Flow Diagrams > Data Flow Diagram

Flow Diagram Browser window Toolbar : New Diagram icon > Data Flow Diagrams > Data

Flow Diagram

Browser window context menu | Add Diagram... > Data Flow Diagrams > Data
Flow Diagram

Usage of the Data Flow The Data Flow diagram can be used to create a data- and process-centric view of a
Diagram system at any level. While the BPMN Business Process diagram is not centered on
data the Data Flow diagram is data-centric and shows which Processes consume,
produce and store data. The diagrams are useful for a data analyst who needs to
know how data moves through a system, from the context level where data flows
between external entities and through the system down to the lowest level.

Options for the Data Flow The Data Flow diagram can be assembled into a hierarchy, and drill down to lower
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Diagram level diagrams can be achieved using the child diagram functionality. The
Processes can be organized into a hierarchy using the Browser window; the child
diagrams can be nested under each Process node in the Browser window.

Toolbox 0O =
More tools... |&

-l Data Flow Diagram

3 Process
[ External
— Data Store
#w Data Flow
[}

Gate —

Colors can be used to represent particular data and how it flows through the
system. Target and Future State diagrams can be drawn and transitions can
describe how processes can be improved and made more efficient.

The Data Flow diagram (like any diagram) can be viewed as an element list, which
makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams, to draw attention
to parts of the diagrams, and the diagrams can be presented as hand drawn or in a
whiteboard style by changing the diagram properties.

Learn more about the Data Flow Diagram
Data Flow Diagram
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Data Modeling Diagram

Getting to know the Data Modeling Diagram

Introducing the Data The Data Modeling diagram is used to create or view graphical models of
Modeling Diagram relational database system schemas including a range of database objects. The

diagrams can be drawn at a logical or a physical level. When a physical schema is
being represented the modeler can choose the correct RDBMS which will enable
the appropriate data types. Tables, Views, Stored Procedures and other objects are
connected showing the way they are related to each other. Tables are the central
element of the schema and can show the contained columns including datatypes,
indexes and keys.
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= Business Analysis tools, Data Modeling diagram in
Sparx Systems Enterprise Architect

This Database Modeling diagram shows a subset
of the tables that make up the entire schema,
focusing on an Order, the Shopping Cart and the
(cart ItemID = cart Items it contains.

ItemID)

«FK»

+PK_Cart Item

Where to find the Data Ribbon: Design > Diagram > Add > Database Engineering > Extended > Data
Modeling Diagram Modeling

Browser window toolbar : New Diagram icon > Database Engineering >
Extended > Data Modeling

Browser window context menu | Add Diagram... > Database Engineering >
Extended > Data Modeling

Usage of the Data The Data Modeling diagram can be used to create database schemas or to view
Modeling Diagram schemas that have been reverse engineered from a live database connection or
transformed from a more primitive model. It is a useful diagram to visualize the
connections between a variety of database objects. They can also be used to show
traces back to other elements such as Requirements, logical Components, and
Business Rules.

Options for the Data A schema can be created from scratch, generated by a Model Transformation or
Modeling Diagram reverse engineered from an existing database through an ODBC connection. The
schema can contain a range of database objects, including:

e Tables

e Views
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e  Procedures

e Sequences

e Functions

e  Associations

e Database Connections

Primary, Foreign and Unique keys can also be modeled and displayed on the
diagram.

There are also several different notations that can be used, including:

e  Unified Modeling Language (UML)

e Information Engineering

e Integration DEFinition for Information Modeling (IDEF 1X)

The notations can be interchanged by changing the 'Connector Notation' property.

Diagram Filters can also be used when presenting the diagrams to draw attention
to parts of the diagrams, and the diagrams can be presented as hand drawn or in a
whiteboard style by changing the properties of the diagram.

Learn more about the e Create a Data Modeling Diagram
Data Modeling Diagram
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Database Builder

Getting to know the Database Builder

Introducing the Database The Database Builder is the primary tool for working with data models. It is a

Builder purpose built tool that provides a single interface for performing database-related
modeling tasks. New data models and databases can be created or existing ones
reverse engineered into the tool. The data modeler, database owner or
administrator can work within the tool and can connect through to live databases
to synchronize the models with the live databases. There is support for most
database management systems and connections can be made to production,
pre-production, test or development databases.

Database Builder -
k| Database Builder x it
B Q Oracle Columns | Constraints SOL Scratch Pad  Database Compare  Execute DDL

2 g Tables
ADDRESS |Name |Type | Lengthl Scalel PK | Mot Mull |AIias|InitiaI\«"aIue
AUTHOR AUTHOR_ID NUMEER 8 2
CART_ITEM [hamE [VARCHAR2 50 ]
CATALOG GEMNDER NUMEER 8 2 O |
EDITORIAL_REVIEW COUNTRY VARCHAR2 50 [} [}
ITEM BIOGRAPHY VARCHAR2 600 | |

ITEM_AUTHOR
ITEM_CATALOG
ITEM_PUBLISHER

ORDER B Column (NAME) B/ UMB|IIZE| L *@
PUBLISHER Length Type None -

READER_REVIEW BYTE The name of the author provides
- - CHAR a reference for the customer.
SHOPPING_CART This will be @ real name or the

C& Views pseudo-name of the author.
Cg Procedures
53 Functions

Cg Sequences
C@ Packages
L Queries
L& Connections
& sQLServer2012

Where to find the Ribbon: Develop > Data Modeling > Database Builder
Database Builder

Usage of the Database The Database Builder can be used to create new logical and physical data models
Builder and to generate databases from these models. The tool can also be used to reverse
engineer any number of existing databases into a model, allowing models to be
compared and reasoned about.

Options for the Database Data elements such as Tables, Views and Stored Procedures that are represented in
Builder the Database Builder can be connected to other elements in the repository such as
conceptual model elements or Requirements, Use Cases, User Stories, System
Components and more. This allows the models to be traced and impact analysis to
be performed creating a relationship between these important data representations
and the rest of the models.

There is a SQL Scratch Pad tool that can be used to develop and execute ad-hoc
SQL queries against a live database via an ODBC connection.

= S N NS NS NN )

(c) Sparx Systems 2019 Page 41 of 153 Created with Enterprise Architect



Business Analysis Tools - Business Analysis Tools 20 January, 2020

A Database Compare tool allows a data model to be compared to a live database
and if required to be synchronized accepting the changes in either direction.

The Execute DDL tools allows Database Definition Language (DDL) statements
generated from the models to be executed against a live database and for the
results to be viewed and analyzed.

Learn more about the Database Builder
Database Builder
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Decision Tree Diagram

Getting to know the Decision Tree Diagram

Introducing the Decision
Tree Diagram

Where to find the Decision
Tree Diagram

Usage of the Decision Tree
Diagram

Options for the Decision
Tree Diagram
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Decision Trees are an effective way of graphically representing a number of
options and provide a mechanism to investigate the possible outcomes and
benefits of choosing those options. They can also assist the analyst to form a
balanced picture of the risks and benefits associated with each possible course of
action. They are a close cousin of the Decision Table but have the benefit of being
graphical. Enterprise Architect has a purpose built diagram allowing complex
decisions to be modeled and displayed including probabilities and uncertainty.
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Ribbon: Design > Diagram > Add > Strategic Modeling > Decision Tree

Browser window Toolbar : New Diagram icon > Strategic Modeling > Decision
Tree

Browser window context menu | Add Diagram... > Strategic Modeling > Decision
Tree

Decision Trees can be used to help in decision making processes particularly when
the decision involves a complex set of conditions that have different likelihoods of
occurrence. They can be used for strategic or operational decision analysis and can
help to formalize the basis of decision making particularly when it is imperative
that actions that are taken are based on formal analysis or have expensive
consequences. A Decision Tree can be used to present a graphical picture of a
Decision Table for stakeholders who are more comfortable viewing diagrams
rather than tables and documents.

Decision trees can be drawn with varying levels of formality from simple trees
with a series of decisions resulting in outcomes to more formal trees that involve
uncertainty with probability values assigned or formulaic expressions with input
parameters. The 'Decision Tree' toolbox page contains a range of elements that can
be used, and two Patterns that can be used to create a diagram giving the analyst a
starting point.
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Toolbox 0 =
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Diagram Filters can also be used when presenting the diagrams to draw attention
to parts of the diagrams and the diagrams can be presented as hand drawn or in a
whiteboard style by changing the properties of the diagram.

Learn more about the Decision Tree Diagram
Decision Tree Diagram
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Decision Table Editor

Getting to know the Decision Table Editor

Introducing the Decision The Decision Table Editor provides a convenient and intuitive way to record the
Table Editor way that decisions are made in an organization or industry. A number of
conditions can be defined and columns can be added that contain values, one or
more conclusions can be added with applicable columns where the decision value
is entered. The Decision Table Editor is based on the Object Management Groups
(OMG) Decision Model and Notation (DMN) specification and can be used to
generate implementation code using predefined macros.

An analyst will occasionally need to record the way that decisions are made in an
organization in a formal way. There is often also the need to express the
conditions and the resulting decisions in a way that will assist an implementation
team design a solution. The Decision Table Editor built into Enterprise Architect
can assist in expressing and implementing the way that decisions are made.

H|== 4 |®|@

uc 1 2 3 4 5
Applicant Age | =25 25 [25.60] =60 =60
Medical History good bad - good bad
Aggregation=sum 1 2 3 4 5
Applicant Risk Rating Low Medium Medium Medium High

Where to find the Decision Ribbon: Design > Impact > Decisions > Manage Decisions
Table Editor

Usage of the Decision An analyst will occasionally need to record the way that decisions are made in an
Table Editor organization in a formal way. There is often also the need to express the
conditions and the resulting decisions in a way that will assist an implementation
team design a solution. The Decision Table Editor built into Enterprise Architect
can assist in expressing and implementing the way that decisions are made.

Options for the Decision The Decision Table Editor can be used simply to record the conditions and the
Table Editor conclusions that form the basis of decision making. Alternatively implementation
code can be generated using the Enterprise Architect Simulation Library (EASL)
code generation macros.

F = = T
] | =z =c r::: @l e -

Learn more about the Decision Table Editor
Decision Table Editor
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Deployment Diagram

Getting to know the Deployment Diagram

Introducing the The Deployment diagram is one of the Unified Modeling Language (UML)
Deployment Diagram Structural diagrams that can be used to model infrastructure, including a wide
range of deployment environments. Both physical and virtual environments can be
modeled, including infrastructure and networking services and protocols.

NYCPROD-WEBS-002: Dell Blade Server NYCPROD-DBS-007: Dell Blade Server
RAM = 2048 RAM =2048 MB
Blades = 4 Blades = 10
Disk Controller = Raid 5 Disk Controller =Raid 5
«executionEnvironment» «execuhonEnvwr?nmem» )
o P A Release 7.1: Red Hat Linux Enterprise
[} (]
q q «executionEnvironme...
executionEnvi...
«execution=nvi 192.168.0.2 / ea 216.239.46.95 / ea -Oracle
:Apache =
«executionEnvi...
:Glassfish

O

This Deployment Diagram shows how
environments can be described using building
blocks from a Technical Reference Model. The
elements on this diagram are instances and in
the case of servers are named. A Port has been
used to describe the Ethernet connection
between the two servers.

Where to find the Ribbon: Design > Diagram > Add > UML Structural > Deployment

Deployment Diagram Browser window Toolbar : New Diagram icon > UML Structural > Deployment

Browser window context menu | Add Diagram... > UML Structural > Deployment

Usage of the Deployment The Deployment diagram can be used to model a wide range of infrastructure and
Diagram networking environments including physical and virtual environments. It is quite
common to model a number of different environments including: production,
pre-production, test and development environments. The diagram can be used to
model Servers, Devices, Networks, Execution Environments. Switches, Routers,
IP Addresses and the software components and Artifacts deployed.

Options for the It is quite common to use the Deployment diagram to model a number of different
Deployment Diagram environments, including production, pre-production, test and development
environments. Alternative images can be used in diagrams to represent
infrastructure and networking devices, such as Networks, Servers, Routers,
Switches and more, making the diagrams more compelling and appealing to their
audience. The diagrams can be included in documentation generated automatically
using the Document Generator.
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Toolbox O =
More tools... |-

=] ployment

Mode
Device
Execution Environment

Dy
=
o
&
{| Component
o
=
=

Interface
Artifact
Deployment Specification
Package
= Deployment Relationships

/  Associate
':P‘ Communication Path
A5 Assodiation Class
A Generalize
A Realize
"P‘ Deployment
"A Manifest
A Mesting
= Deployment Patterns
¥% Basic Deployment =

There is a toolbox that contains a range of elements, relationships and Patterns for
creating Deployment diagrams.

The Deployment diagram (like any diagram) can be viewed as an element list,
which makes working with element properties easier.

Diagram Filters can also be used when presenting the diagrams, to draw attention
to parts of the diagrams; the diagrams can be presented in hand drawn or
whiteboard style by changing the properties of the diagram.

Deployment Diagram
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Document Artifact

Getting to know the Document Artifact

Introducing the Document A Document Artifact is similar to a word processor file that can be created and
Artifact stored directly inside the model to record structured documentation. It is a

light-weight and convenient alternative to creating a document in your favorite
word processor. It has many of the features you would expect in a word processing
tool, and allows you to create hyperlinks to content in the modeling Repository.
An analyst will often be required to create structured documentation in addition to
what might properly be placed in an element's notes or in a corporate document
repository. This could include things such as interview plans, focus group agendas,
surveys and more. There is rarely a requirement to store this type of
documentation in a corporate document repository, and storing them inside the
modeling repository has many benefits, including being able to include hyperlinks
to elements and diagrams contained in the Browser window.

D Sales Lead Management Requirements Interview 4 b
ODAd&ER 3+ B oo [ 84| By (] & | @ 100 *  normal.rtf M
Cover Text 1 *  Arial T 14 TR I UMES=E=|-2E

m

<Company Logo>§

Sales Lead Managementé
Requirements
Interview

Version 1 0

Where to find the Toolbox: Common, Artifacts, Component, Documentation, Deployment Toolbox
Document Artifact Page | Document Artifact

Usage of the Document A Document Artifact can be used to add structured documentation in the form of a
Artifact word processor (rtf) file. This can be a standalone element or it can be linked to
another model element. In large organizations there is often a corporate repository
for documents but in smaller organizations or when a document is less formal the
document Artifact can be a useful mechanism for storing information. For example
it can be used to document or plan a stakeholder workshop or focus group.

Options for the Document When a Document Artifact is created there is an option to use a built-in or user
Artifact defined template. Any number of templates can be created for documents such as
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focus groups, workshops surveys and plans.
Mission Wision E]
System Templates -
Defect Audit

Deployment Plan
Hardware Dedsions

Integratinn Flan

Phase Review

Flatform Decisions
Project Chedklist
Release Plan
Reguirements Approval
Resource Plan

Risk Plan

Source Code Review a
Test Plan

Test Results Review

m

-

Elements and diagrams can be dragged onto the document from the Browser
window, which allows readers to click through from the location in the document
to the diagram or element.

Many of the features found in Word Processors are available, such as inserting
pictures and tables, creating Tables of Contents and headers and footers, tracking
changes to the document and more.

Learn more about the Create Document Artifact
Document Artifact
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Documentation

Getting to know Documentation

Introducing The documentation features can be used to automatically generate a wide range of
Documentation documentation directly from the models. These can be document based such as
PDF and Docx format or html based. Flexible templates can be used to completely
tailor the documents that are generated including company logos, tables of
content, tables of element information and diagrams. Ad-hoc reports can also be
created from a number of tools such as the Glossary and the Search Window.

Package: Functional Requirements [_-e"
Output to File: C:\Users\PubliciDocuments \Functional Requirements. pdf

Template: Model Report =
Cutput Format : Portable Document Format (PDF) =
Cover Page: Paortrait ~
Table of Conterts: | Portrait ~
Styleshest: Help Style Sheet -
Diagram Theme: Ice - Fine h
Watermark:

Where to find Ribbon: Publish > Model Reports > Report Builder
Documentation

Use of Documentation Modelers, Analysts, Architects, Project managers and others can use the facility to
produce a wide range of document based publications and reports, such as a
System Requirements Specification, Use Case Report, Data Dictionary, Solution
Architecture Description and more. It can also be used for Ad-hoc reporting to
create reports such as a list of the most volatile requirements. Html documentation
can also be published to allow stakeholders who don't have access to Enterprise
Architect to view the models from an Intranet site that can just be placed on a file
system without the need for a Web Server.

Options for There are several options that can be set to tailor the information that is included
Documentation in a generated document, including the ordering of elements and diagrams and
hiding certain elements. Filters and word substitutions and other options can also
be applied.
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Order Eilter
gl BCkAgESbY.  Tree Order ~  Ascending - Only include abjects:
Created ~ After - 15/052018 -
Elementsby:  Tree Order - Ascending 2

Where Package Phase:

Diagrams by  Tree Order - Ascending - = -

With element status:

Options
DHidg'note—Iess' elements H_ide Diagram Borders -

] Propagate Package Filters [THide nan-printable objects Connector Direction:

[“IHide 'note-less' connectors ["] show status colors Both -

[JHide <Anonymous= elements [ Mo bockmarks Extentwrises e Gniery Eachides
DDisabIeIarge OLE file support DSEip root package (*) Custom SQL ) Custom Seript

O Use style defined in template for notes

[ insert page breaks when generating a Master Document
[Jnclude child elements even if the parent element is filtered out
[]indent Linked Document Headings

Diagram Format: Metafile + [ set as Default

Adjust Heading Levels: Heading 9 -

Switch generator

Learn more about Model Publishing
Documentation
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Element Appearance

Getting to know Element Appearance

Introducing Element All elements in the repository have a global default appearance, which is defined
Appearance in the Options Window. Individual elements can set a global appearance that
overrides the default setting for all elements and applies to the specified element
wherever it appears in diagrams. An element's appearance can also be changed at
the level of an individual diagram by using the color and font pickers. Images and
other shapes can also be applied to make the element more appealing.

9

Business Analysis tool,
element tracing in Sparx
Systems Enterprise Architect
This Custom diagram shows
the relationship between

Stock Control elements from different parts
Manager of the Repository. It links a
BPMN Activity with the

stakeholder who owns the
process and the system that
will ultimately provide the
computational service.

«trace»
|
1
ory Manager
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Context Menu: Appearance | Default Appearance

Local for a Diagram Object
Ribbon: Layout > Style > Set Font, Text Color, Fill Color, Line Color, Line Width

Diagram Toolbar (right-click on element in diagram): Set Font, Text Color, Fill
Color, Line Color, Line Width

Element Icons: Set Font, Text Color, Fill Color, Line Color, Line Width (top right
corner of diagram object, under Quicklinker arrow))

Usage of Element The Element Appearance is useful to convey different meaning to a number of
Appearance audiences and stakeholders. The global element settings ensure the entire

repository is by default consistent and these can be changed to suite an
organization. The default element appearance settings ensure that an element is
consistently represented whenever it is used on diagrams. The local appearance
settings allow an element to appear differently on a specific diagram. Some
stakeholders will also prefer to see an element represented as an image or by a
different shape.

Options for Element Apart from the setting of Font Style, Text Color, Element Fill and Border Color
Appearance and Line thickness. elements can be assigned an alternate image or a completely
different geometry using the Shape Script facility, which is applied to a stereotype.
The images can be assigned from the

Learn more about the Set an Element's Default Appearance
TOOL
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Element tab of the Browser Window

Getting to know the Element tab of the Browser window

Introducing the Element
tab of the Browser window

Where to find the Element
tab of the Browser window

Usage of the Element tab
of the Browser window

Options for the Element

(c) Sparx Systems 2019

The 'Element' tab of the Browser window provides a view of all the important
aspects of an element including Attributes, Operations, Tagged Values, Files,
Internal Requirements, Relationships, Constraints, Maintenance and Project
Maintenance Items and more. It is a useful window to use in conjunction with
another tab of the Browser window as it provides all the details of an element
selected in the other tab conveniently collected in a single view.
Element Browser O x
Transaction
= [ Operaticns
¢ loadAccountHistony()
¢ loadOpenCrders()
= ] Attributes
J date: Date
¢ orderMumber : String
| Linked Features
__| Tagged Values
__| Constraints
__| Requirements
| Files
=[] Relationships
q'-u Aszociation:Account [Class]
q'-u Aszociation:Order [Class]
q'-u Realization::Go To Checkout [UseCase]
__| Scenarios
| Maintenance
E [ Testing
= [T Unit
Tl [ Mot Run] Confirm quantity
il [ Deferred ] Mo History
Tl [ Mot Run] View History
Gl [ Mot Run] Zero Quantity
__| Project Management

Ribbon: Explore > Portals > Windows > Explore > Element Browser

Ribbon: Start > Desktop > Design > Browser > Element

The "Element' tab of the Browser window can be used to view and to edit all the
important aspects of an element. While the 'Project' tab of the Browser window
will help the modeler navigate through and locate elements in the repository, the
'Element' tab will allow the element to be explored in detail.

The 'Element' tab of the Browser window can be used to view and edit most of the
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tab of the Browser window aspects of an element. For example, Relationships can be viewed and deleted,
Attributes and Operations, Constraints, Project Management and Maintenance
items and more can be viewed and new ones created. Switching to the 'Element'
tab while viewing elements in the 'Project’ tab of the window will give a simple
overview of which aspects of the element have been detailed, without the need to
expand the + indicator to view the details.

Element Browser O x
@ As a Stock Contrel Manager I want to be able to list stock levels for a selection of titles,
] Operations
| Attributes
| Linked Features
= [ Tagged Values
% Volatility = High
= [ Constraints
73 The solution must use available Stored Procedures
=[] Requirements
Back ordered titles must only be included in total when the available stock is zero.

A user must be warned when the report generation time is going to be more than or

| Files
] Relationships
] Scenarios
=[] Maintenance
= [ Tasks Add Mew Defedts
o0 [ Mew ] Create application logic to display res Add New Changes
o0 [ Verified ] Create table index to ensure fast re Add NE&SSUES
5 [ Mew ] Decide on Ux mechanism to multisels Add Mew Tasks
= [3 Decisions Add New Decisions
7l [ Verified ] Display back order as negative sto Add New Events

|_] Testing
] Project Managernent

New items can be added to the element and existing ones deleted directly from the
'Element' tab, from the context menu.

Learn more about the Element tab of the Browser window
Element tab of the
Browser window

(c) Sparx Systems 2019 Page 55 of 153 Created with Enterprise Architect


http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/modeling_tools/theelementbrowser.html

Business Analysis Tools - Business Analysis Tools 20 January, 2020

Element Discussions

Getting to know Element Discussions

Introducing the Element The Element Discussions facility allows modelers to have conversations about
Discussions elements posting discussions and replying to exiting posts. The discussions for all
elements in the model are conveniently listed in the Discussions Review window
allowing a modeler to see all the elements with posts.

Collaborate v 1 x

Review Discuss Chat

=— REQ116-The system must email the client a copy of the receipt -

F {-\\ Frank Mclver /052015

(17 Isitmandatory for a custorner to supply an email address and
if not how should the receipt be transmitted?

& Greg Michals 8052015

The email is a mandatory field unless it is stored in the
customer profile - either way we will have it

Where to find Element To post or view an element's discussion

Discussions  Ribhon: Start > Collaborate > Discussions > Discuss

To view recently discussed elements

Ribbon: Start > Collaborate > Discussions > Recently Discussed Elements

To view all discussions in the repository

Ribbon: Start > Collaborate > Discussions > Discussion History

Usage of Element Element Discussions allow modelers to have conversations about elements
Discussions without 'polluting' the element's notes with questions and modeling level
comments such as 'Properties need to be added before the first release'. This
feature brings the collaborative modeling platform alive where modelers can add
informal discussions about elements emulating the discussions held in a physical
workshop.

Options for the Element The Discussion Review window has a number of options to tailor the discussions
Discussions that are listed including defining the timeframe allowing older and perhaps less
relevant discussions to be hidden.
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Learn more about Element
Discussions
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Show Preview Pane

Refresh

Informal Discussions
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Entity Relationship Diagram

Getting to know the Entity Relationship Diagram

Introducing the Entity The Entity Relationship diagram is a visual device used to model information or

Relationship Diagram data and is used as a schema that is a precursor to database modeling. There are a
number of different representations that can be used but the style used in
Enterprise Architect uses rectangles to represent Entities, ellipses to represent
Attributes and diamonds to represent connections between Entities.

Entity-Relationship Diagrams

Entity Relationship Diagrams in Enterprise Architect are based on Chen's ERD building blocks:
Entities (tables) are represented as rectangles, Attributes (columns) are represented as ellipses
(joined to their entity) and Relationships between the entities are represented as diamond-shape
connectors.

ERD technology in Enterprise Architect assists you in every stage, from building conceptual data
models to generating Data Definition Language (DDL) for the target DBMS.

Entity-Relationship Diagrams are available from the category 'Entity Relationship Diagrams'.

Order
Value
Email Order
Address Date
Customer Order
Order
Instructions

Drder
Number

Where to find the Entity Ribbon: Design > Diagram > Add > Database Engineering > Entity Relationships
Relationship Diagram > Entity Relationship Diagram > ERD DP

Browser window Toolbar : New Diagram icon > Database Engineering > Entity
Relationships > Entity Relationship Diagram > ERD DP

Browser window context menu | Add Diagram... > Database Engineering > Entity
Relationships > Entity Relationship Diagram > ERD DP

Usage of the Entity They are used by some data modelers as a way of ensuring independence from the
Relationship Diagram physical data models that are used to represent the schema of a given Relational
Database Management System database. They also provide a more appealing
means of communicating with non technical stakeholders.

Options for the Entity Entity Relationship diagrams can be drawn to include all of the Entities in a given

Relationship Diagram domain in a single diagram or, alternatively, a number of diagrams can be created
for different aspects of the domain. Diagram Filters can be used in presentations to
focus on specific parts of a diagram that are of interest to the audience. The
Documentation Generator can also be used to produce a data dictionary describing
the Entities, their Attributes and their relationships with other Entities.
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Toolbox 0O =
Mere tools... |-
= ERD
@ Entity 3
O Attribute

<~ M-ary Association
=] ERD - Relationships

Connector
Relationship
Disjoint

N

Cwerlapping

The Diagram Toolbox contains a range of elements, relationships and Patterns for
creating Entity Relationship diagrams.

The Entity Relationship diagram (like any diagram) can be viewed as an element
list, which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention
to parts of the diagrams, and the diagrams can be presented as hand drawn or in a
whiteboard style by changing the properties of the diagram.

Learn more about the Entity Relationship Diagram
Entity Relationship
Diagram

(c) Sparx Systems 2019 Page 59 of 153 Created with Enterprise Architect


http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/model_domains/entity_relationship_diagrams_e.html

Business Analysis Tools - Business Analysis Tools 20 January, 2020

Flow Chart Diagram

Getting to know the Flow Chart Diagram

Introducing the Flow The Flow Chart Diagram is a strategic diagram that allows the steps in a process,
Chart Diagram workflow or algorithm to be ordered in a sequence and displayed graphically. The
steps are modeled as rectangles and choices are modeled as diamonds, there are
inputs and outputs and data stores available for modeling the things that are
consumed, produced and stored by the process.
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Where to find the Flow
Chart Diagram

Flow Chart Diagram

AFlow Chartis a graphical representation of a sequence of events, helping
decision makers understand the relationship between their decisions and a
given outcome. Flow Charts use a range of simple geometric shapes to
represent a process, decision, storage or output.

Flow Chart diagrams are available from the 'Strategic Modeling' category. The
associated toolbox offers a range of elements and connectors that specifically
target that diagram type.

Credit Card Purchase

Customer
Preferences

% Valid Credit

Sufficient Funds
Available?

Send Customer §,
Confirmation

Order Fulfilled

Ribbon: Design > Diagram > Add > Strategic Modeling > Flow Chart

Browser window Toolbar : New Diagram icon > Strategic Modeling > Flow
Chart

Browser window context menu | Add Diagram... > Strategic Modeling > Flow
Chart

(c) Sparx Systems 2019
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Usage of the Flow Chart
Diagram

Options for the Flow
Chart Diagram

Learn more about the
Flow Chart Diagram
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The Flow Chart Diagram can be used for visualizing, analyzing and

20 January, 2020

communicating about the steps and outcomes in workflows, processes and

computer

algorithms.

Flow Chart Diagrams can have nested Activities allowing hierarchies to be
defined. Responsible parties can be defined by the use of swim lanes.

Toolbox
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Maore tools...

= Flow Chart
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On Page Connector
Off Page Connector
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Report

Annotation

Connector

= Patterns

%]

Flow Chart

=

Fe

-

The Flow Chart Diagram (like any diagram) can be viewed as an element list

which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention
to parts of the diagrams and the diagrams can be presented as hand drawn or in a

whiteboard style by changing the properties of the diagram.

Flow Chart Diagram

Page 62 of 153

Created with Enterprise Architect


http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/model_domains/flow_chart.html

Business Analysis Tools - Business Analysis Tools 20 January, 2020

Gantt View

Getting to know the Gantt View

Introducing the Gantt The Gantt View is a tool for visualizing the elements in a project, Package or
View diagram and the resources that have been allocated to them. There are a number of
different Gantt charts available:

e The Project Gantt View used to view elements across the entire repository

e Diagram Gantt View used to display the allocation of resources to the
elements in a given diagram.

e Package Gantt View used to display the allocation of resources to the
elements contained in a selected Package.

The tool will empower the traditional or agile project manager to ensure that a
projects resources are allocated to repository content and help ensure high value
outcomes are achieved right from within the repository.

() start Page | Project Gantt View X

August 2015
Resource Status Role or Task Complete
20 n 22 3 24 25

o o P P2
= Ff’ Cathy Ballantine p—_——
= Department Costi.. Approved  Project Manager 10% | I ——
= 7:’ David Jones F
g Element Test Stat.. Approved Developer 0% |
= 7:’ Fred Hopkins F
E Element Test Stat.. Approved Java Programmer 70% | |
= Ff'SaHyCoopEr | e
S Department Costi... Approved VB Programmer W% e

4 4 » M Resource View. Element View Report View

Where to find the Gantt Ribbon: Design > Model > Gantt
View Ribbon: Design > Diagram > View As > Gantt View
Diagram Context Menu: Switch View | Switch to Gantt View

Browser window Package context Menu | Open Package in | Gantt View

Usage of the Gantt View The Gantt View's primary use is to display the allocation of resources to elements
in the repository and to mange the work breakdown structure. There are a wide
range of views and filters that can be applied to tailor the view or to make it more
relevant to a particular audience. Allocations can be made to any elements in the
repository from high level Packages level down to an individual element such as a
Class, Activity or Change. It is a powerful tool for a project managers wanting to
visualize how a team is being utilized and ultimately to deliver high value and
high priority outcomes. Modelers working on a project can view their own work
and update their progress while working on assigned tasks.

While broad changes can be made using the visual duration bars in the Gantt View
it is common practice to use the tool in conjunction with the Resource Allocation

(c) Sparx Systems 2019 Page 63 of 153 Created with Enterprise Architect



Business Analysis Tools - Business Analysis Tools 20 January, 2020

window where fine details can be entered and adjusted.

Options for the Gantt The Project Gantt View is a highly flexible tool that can be configured to display
View information in a number of different ways. Filters can be used to show only
elements that have a particular status or more generally by using the Filter Bar and
finding elements that contain the specified filter text in a particular column. It is
also possible to filter the display by Start or Completion date or to just show
overdue tasks.

Broad changes can be made to the duration of tasks by simply dragging the ends of
the visual bars. The scale of time can be altered on the display to allow short and
long term planning and to get condensed and expanded views.

The Gantt chart can conveniently be copied to the clipboard and pasted in to other
applications or saved into a file. There is a wide range of other options that are
available, making the tool invaluable to a team and schedule-based approach to
modeling.

Refresh

Show Task Properties...

GoTo 3

Display Highlight for Overdue [tems 4

Include Completed Tasks Within the Last YT Days

Display Future Ta& Starting in 4 30 Days

Apply Element Status Filter... 50 Days
All

Find in Project Browser
E] Show Element Resource Allocation Window Ctrl+5hift=7 None

Find Task in Element Resource Allocation Window

Sawve Image to File...

Copy Image to Clipboard

l@l Help

Learn more about the Gantt View
Gantt View
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Gap Analysis Matrix

Getting to know the Gap Analysis Matrix

Introducing the Gap The Gap Analysis Matrix is a specialized Relationship Matrix that is used to
Analysis Matrix record the gaps that exist between two versions of some part of an enterprise. The

gaps between two different versions of an architecture could be recorded, or the
gaps between two versions of Capabilities or Staff Competencies, or two versions
of Information or Data. The tool is structured similarly to a spreadsheet with
columns and rows. The elements that make up the baseline (starting point) are
listed as columns and the elements that make up the target (end point) are listed as
rows. There is a column for recording missing or eliminated elements and a row
for recording new elements. At the intersection of a baseline element and target
element, notes can be added that describe any details of the relationship between
the two elements.

Gap Analysis Matrix O x
T et o1l G I—
Baseline Architecture: [Basslinel ... | Fiter: | age [~ || Record Gap As:| [~ Options |
Video Enhanced Mailing List Missing /
Target Conferencing | Telephony Services Eliminated
Services Services
Baseline
Broadcast Retired service
Services : Intenticnally
eliminated
Video
Conferencing
Services
Included
Enhanced Potential
Telephony match
Services
Shared Screen Address Shared
Services Screen Service :
Unintentionally
eliminated
MNew Improve Mailing List :
Telephony Mew-To be
service: To be | produced or
enhanced developed

Where to find the Gap Ribbon: Design > Impact > Gap Analysis
Analysis Matrix

Usage of the Gap Analysis The Gap Analysis Matrix can be used for both business and technical analysis. It
Matrix is a general purpose tool for recording the details of a comparison between
different versions of some part of an enterprise. In business analysis it can be used
to analyze Staff Competencies, Data and Information, Business Processes, Lines
of Business and more, comparing them between current and future states of an
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enterprise. In Enterprise Architecture the matrix can be used to record gaps
between baseline, transition and target architectures, comparing Capabilities,
Architecture and Solution Components and more.

Options for the Gap The Gap Analysis Matrix can be configured to display different parts of the
Analysis Matrix repository. Once the appropriate Packages have been chosen for the Target and

Baseline, and the types of element have been selected for the filter, the Gap
element type can be selected. The element chosen for the gap will restrict the
available elements to represent the gap for 'Missing' or 'New' elements in cells in
the matrix. There are a number of choices available from the 'Options' menu,
including being able to update, delete and save the Gap Analysis Matrix, giving it
a name so that it can be recalled at a later time.

Update Current Profile
Save as Mew Profile
Delete Current Profile
Help...

Learn more about the Gap Gap Analysis Matrix
Analysis Matrix
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Glossary

Getting to know the Glossary

Introducing the Glossary The Glossary is a project level lexicon of the important terms and their meanings
categorized by type. Any number of terms, their types and meanings can be
defined and these can be referenced from the notes of model elements. The terms
can be included in documentation or generated as a stand-alone report. When
working with domain specific requirement specifications, architectures and other
models it is essential that new terms and over-ridden meanings for common words
or phrases are kept in a suitable dictionary format to ensure proper understanding
of documentation and specifications.

Glossary ltem Details

Tem: Type:
Stock Ttem Business -
Meaning:

B /7 UM Z=|x %

The Stock ltem defines the items (books) that are stocked in the warehouse for
on-line purchase.

Where to find the Glossary Ribbon: Publish > Dictionary > Glossary

Usage of the Glossary The project Glossary can be used to record the important terms of a project or
domain grouped by the type of term, allowing business, technical and domain
specific types to be defined. A glossary report can be generated as a stand alone
report or the glossary can be included as a section of another document.

Options for the Glossary The Glossary has a number of options to determine the terms that are displayed in
the list and to define the style that is used for types of terms in documentation.

¥ Add New...
Assign Markup Styles
FModify Selected...

Field Chooser
Enable Group Box

J=' Toggle Filter Bar

Rename Type...
Set term filter ...

Print List...

W Delete

Learn more about the Model Glossary
Glossary
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Hand Drawn and Whiteboard Mode

Getting to know Hand Drawn and Whiteboard Mode

Introducing Hand Drawn
and Whiteboard Mode

Where to find the Hand
Drawn and Whiteboard
Mode

Usage of the Hand Drawn
and Whiteboard Mode

Options for the Hand
Drawn and Whiteboard

(c) Sparx Systems 2019

Hand Drawn and Whiteboard Mode are display options available for any diagram
that changes a system-drawn diagram to appear as though it was drawn by hand
and, optionally, hand drawn on a whiteboard. It is a powerful device to engage an
audience by presenting the diagram in a rough and more immediate style giving
the impression that it is just a sketch that can be changed.

Both modes will present the diagram in a hand drawn style but the whiteboard
mode will change the Fill color of the elements and the diagram background to
white as though it had been drawn on a whiteboard.

0.25

Ribbon: Layout > Diagram > Appearance > White Board Mode or Hand Drawn
Mode

Diagram Context Menu: Properties | Diagram | Whiteboard Mode or Hand
Drawn

The Hand Drawn diagram mode is a perfect tool for use in workshops and
presentations to internal or external customers, as a way of softening the
representation of more formal elements that are normally displayed in their more
rigid geometric forms. Audiences will tend to respond to the diagrams more
favorably as they appear to be just sketches and not yet resolved as finished
diagrams. Stakeholders who are not familiar with the formal modeling languages
such as UML will typically be more engaged by these diagrams.

The Whiteboard mode will give the appearance that the diagram was sketched on
the whiteboard, again adding an immediacy to the drawing.

Both the Whiteboard and Hand Drawn modes of presentation can be carried
through to generated documentation that contains the diagram.

The Whiteboard mode will give the appearance that the diagram was sketched on
the whiteboard again adding an immediacy to the drawing.
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Mode Both the Whiteboard Hand Drawn mode of presentation can be carried through to
generated documentation that contains the diagram.

Learn more about the Hand Drawn and Whiteboard Mode
Hand Drawn and
Whiteboard Mode
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Getting to know the Image Manager

Introducing the Image
Manager

Where to find the Image
Manager

Usage of the Image
Manager

Options for the Image
Manager

(c) Sparx Systems 2019

The Image Manager is used to manage pictures in the Repository, allowing them
to be maintained and reused across diagrams. Images can be inserted in a variety
of formats including Bitmaps and Extended Windows Metafiles are then used to
change the conventional appearance of elements to create more appealing and
compelling diagrams.

Loaded Images

Name | File Type Reference Freview

Laptop Metafile Global a

Laptop-Multiple Metafile Global

Laptop-Spare Metafile Global

LCD Monitor Metafile Global

Legal Department Metafile Global

Licensing Site Metafile Global

Lock Metafile Global

Lock & Key Metafile Global

Mail Metafile Global View

Mail List Metafile Global 5

Mail Room Metafile Global Usage
Mainframe Metafile Global Rename
Mainframe-Multiple Metafile Global

Management Metafile Global AddNew |+
Manufacturing Metafile Global Update Selected. .
Marketing Metafile Global

Mobile Phone Metafile Global Delete
Modem Metafile Global

Packaging Metafile Global Close

Patch Panel Metafile Global
Payroll Metafile Global - —

1 i 3 Help

Defining Images

Ribbon: Configure | Reference Data | Images

Using Images

On diagram, right-click element | Appearance | Select Alternate Image

The Image Manager's main use is to define pictures that can be used as alternate
representation for elements in diagrams. For many business and networking
diagrams the default appearance of an element such as a UML Class or
Component can be replaced with an image from the Image Manager making the
diagram more appealing to its audience. The Image Manager will also store
images that are defined in included technologies.

The Image Manager allows Images to be imported in a variety of formats
including Bitmaps and Extended Windows Metafiles. Images can be imported
from the file system or conveniently from the Clipboard.
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Add Mew |v | I

From File

From Clipboard

There is also an option to display the diagrams where the image has been used.

Learn more about the Image Manager
Image Manager
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Import and Export Spreadsheets

Import and Export Spreadsheets

Introducing Import and
Export Spreadsheets

Where to find Import and
Export Spreadsheets

Use of Import and Export
Spreadsheets

Options to Import and
Export Spreadsheets

Learn more about Import
and Export Spreadsheets

(c) Sparx Systems 2019

This facility is a useful mechanism to import Requirements that have been defined
in a Spreadsheet or a Word Processor table into Enterprise Architect. Once in
Enterprise Architect the Requirements can be managed and traced to elements
such as business drivers and Scenarios and Components. Alternatively
Requirements in Enterprise Architect can be exported to a Spreadsheet for the
purposes of providing them to a third party or for some type of numerical or
statistical analysis. The mapping between fields in the Spreadsheet and the
analogous properties in Enterprise Architect is completely configurable using a
specification.

For more detailed information exchange, the Microsoft Office Add-In (available
from Sparx Systems) provides additional functionality and integration points
useful when dealing with complex Requirements.

Package: Functional Requirements =]
Specification: | Online Store Requirements - Edit/New...
Eile: C:\Users\PubliciDocumentsOnline Store Requirements. csv

Types: Reqguirement

Code Page: | 65001 (UTF-8)

Action
i@ Import i) BExport

Ribbon: Publish > Model Exchange > CSV

This feature can be used to import or export Requirements from a CSV file. Before
a tool such as Enterprise Architect is installed, analysts might have used a
Spreadsheet or a table in their favorite word processor to record requirements;
these can conveniently be imported using the CSV import facility. Alternatively,
Requirements sometimes have to be provided to a third party who will typically
specify that they want them in a Spreadsheet file; this can be achieved using the
export facility.

The import and export facility is completely configurable and has a user defined
specification that can be used to determine how fields in the Spreadsheet file are
mapped to Requirements properties in Enterprise Architect including being able to
import and export fields to and from Tagged Values of the Requirement.

CSV Import and Export
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Info View

Getting to know the Info View

Introducing the Info View The Info View is an alternative representation for an element that is typically more
appealing to managers or non-technical stakeholders. The Info View displays the
name, stereotype, notes and a small icon that represents the shape of the element.
Other element properties can be displayed by using the 'Visible Properties' dialog.

REQ156 - The solution must be
able to manage leads from initial
enquiry through to a customer
order

Requirement «evaluation criterias
Validated
ersion: 1.0 Phase: 1.0

The current system has two
separate databases, one for leads
and one for customers and it is not
possible to connect them due to
disparate keys. Much time is wasted
re-keying details of a lead into the
customer database, errors are
made and leads are lost. The new
system must have a single view of a
lead and a customer.

Where to find the Info Element Context Menu: Info View | Enabled

View Element Context Menu: Info View | Visible Properties

Usage of the Info View The Info View is a useful alternative representation of an element in a diagram
which is often appealing to managers and high level stakeholders. The Info View
will show the name of the element, a small Icon that signifies the type of element,
additional properties and the element's notes. It is useful in situations where the
audience of the diagram does not need to know about the details such as
Attributes, Operations, Database Columns, and other details.

Options for the Info View The properties that are displayed by the Info View representation can be
configured to make the element more meaningful to particular audiences. The
'Visible Properties' dialog allows properties to be selected for display.
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Info View &Properties

Items
Status
+| Version
+| Phase
Author
+| Icon
Capitalize Name
Tagged Values

¥ Maintenance Items —

A portion of the notes will be displayed using the available space in the Info View;
if all the notes need to be displayed the diagram element can be resized to provide
space for the text.

Learn more about the Info Info View
View

(c) Sparx Systems 2019 Page 75 of 153 Created with Enterprise Architect


http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/modeling_tools/infoview_style.html

Business Analysis Tools - Business Analysis Tools

20 January, 2020

Insert Related Elements

Getting to know Insert Related Elements

Introducing Insert Related
Elements

Where to find Insert
Related Elements

Usage of Insert Related
Elements

Options for Insert Related
Elements

(c) Sparx Systems 2019

Insert Related Elements is a powerful productivity and exploration tool that allows
diagrams to be created automatically from relationships that exist in the repository.
Typically elements are added to the repository by a number of modelers and no
single person will be totally aware of all the elements in the repository and their
relationships. By placing a single element onto a diagram that acts as a context (or
starting point) the Insert Related Elements facility can be used to explore the
element's connections and to automatically draw a diagram using the context
element as a starting point. Powerful and expressive diagrams can be created that a
modeler will not have seen before or not thought of creating.

A BB -1 2 ¥ P Default style C WL B E AR B-F X

M A ]

% Z|
é % Insert Related Elements X
Z 7
Z Z
é E Connector types: A~ Element types: A
7
é L | = Assodation @ Activity
Z
é é = SequenceFlow 4 Gateway
Z
Z =
7 Stock Control %
Z Z
Z Y
b BRI it
Link Direction: Outgoing - | Find relationships to: | 2 - | levels

Limit to Namespace: | <None> s

Al Clear Refresh Clear
Drag a column header here to group by that column,
Depth Mame Package In Diagram
| o1 D As a Stock Control Manager | wantto ... User Stories Mo
|:| 1 ﬂ Inventory Manager Application Tier Mo
| 2 A REQ171 - The solution must allow stoc.. Functional Mo
|:| 2 D Johnny Cavair-Parkinson Cut of Scope Stakeho... Mo
|:| 2 D Theresa Borantoni Out of Scope Stakeho... Mo
|:| 2 D Zoe Uppleton Out of Scope Stakeho... Mo
0 1 3D Check Stock Availability Crder Management Mo
a 2 4 Stock Available? Order Management Mo

Ribbon: Design > Element > Add > Related Element

On diagram, right-click on element | Insert Related Elements

The Insert Related Elements facility can be used to create a diagram automatically
from its relationships in the repository, including the relations of the related
elements themselves down to a deeper level. It can also be used as a discovery tool
where the modeler wants to explore a model (or part of a model) they might not be
familiar with. It is also useful in workshops when a number of model authors or
other stakeholders are present to show the traceability between different parts of a
repository.

Insert Related Elements has a flexible interface that allows the modeler to
configure what types of relationship to include in the discovery, the direction of
those relationships, the types of related element to be included, the depth of the
graph traversal and more. The related elements can be from a specified
namespace, and once a set of related elements has been listed the modeler can
choose which elements to insert into the diagram. A depth of 1 will just include
the elements directly related to the context element, a depth of 2 will include the
directly related elements and any elements directly related to them, and so on up to
a depth of 5.
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B Insert Related Elements >
Connector types: ﬁl | - | Element types: ﬁl | -
=} Aggregation X ﬂ Component X

= Association D 1 FunctionalRegquirement 1
= Dependency ]
T [l 4 . N e o [l 4

Link Direction: |Ir1r.:oming - | Find relationships to: levels

Limit to Namespace: |§None> - |
Al Clear Refresh Clear

FY
Depth Mame Package In Diagram |
=] Package: Actors
o 3 % Products Manager Actors Mo
0o 3 2 Chief Editor Actors Mo
|-| Package: Application Tier
|:| 1 ﬂ Inventory Manager Application Tier Mo

There is also the option to allow the tool to layout the diagram after the elements
have been inserted.

Learn more about Insert Insert Related Elements
Related Elements
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List View

Getting to know the List View

Introducing the List View The List View is a powerful tool for viewing the contents of a Package or a
diagram as a list of elements, allowing the elements' properties to be viewed and
edited in a convenient spreadsheet-like view. Many analysts will prefer to view
elements in a list, and when details are changed the changes will be effective in
every other view of the element, including diagrams and the Browser window.

There are a number of options for filtering, sorting and grouping elements in the
list based on a wide range of properties and Tagged Values.

Package Browser r X
@Start Page mﬂook Store Domain < 1 F
e « Information Models » Book Store Domain  » Find Package
Y
Status -~
L Type
| "lName - | status «1| Type - | Modified A

—| Status: Approved

=| Type: Class
Reader Review  Approved Class 117/2016
Review Approved Class 1172008

Item Approved Class 12/15/2015

—| Type: Enumeration

Category Approved Enumeration 117/2016

—=| Status: Proposed

—| Type: Class

Catalog Proposed Class 11/2/2015

Cart Item Proposed Class 8/17/2015

Address Proposed Class 11/2/2015

Shopping Cart Proposed Class &M17,/2015 -

Where to find the List Ribbon: Design > Model > List View
View  Ribbon: Design > Diagram > View As > List View
Diagram Context Menu: Switch View | Switch to List View

Browser window, Package Context Menu: Open Package in | List View

Usage of the List View The List View can be used to get a different view of the elements contained in a
Package or a diagram and to visualize their properties in a single spreadsheet-like
view. It is particularly useful when dealing with non technical audiences or when
the elements need to be sorted, filtered or grouped based on criteria such as Name,
Status, Phase, Version and more. Project Managers and others working with sets
of elements will be able to analyze in a given Package or diagram. There is also a
related Gantt View where resource allocations, work completion and timings can
be visualized.

Options for the List View Additional properties can be added by using the 'Field Chooser' dialog and Tagged
Value columns can also be added, allowing a modeler to view the elements' native
properties and Tagged Values side-by-side. The elements in the list can also be
exported to a document report using any number of built-in or user defined
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Learn more about the List

templates and generating to a variety of formats including Docx, PDF and RTF.

B
#

=]
X

Properties...
Edit Notes (Ctrl=Shift=5Space]

Create Linked Document
Add New Element

Find in Diagrams...
Find in Project Browser...

Bookmark Item...
Switch to Gantt View
Documentgtion

Sort Contents
Reload
Add Tag Value Column

Columns Layout
Print
Delete Selected

Help

List View

Ctrl=Alt=D

Llass

Class

GUIEIement
GUIElement
GUIElement
GUIElement
GUIElement
GUIEIement
GUIEIement
GUIElement
GUIEIement

19-Jan-13
04-Feb-13
29-Feb-16
29-Feb-16
29-Feb-16
29-Feb-16
29-Feb-16
29-Feb-16
29-Feb-16
29-Feb-16
29-Feb-16

Generate Documentation for each selected Item...

Generate Documentation for selected tems...

= Print

STATE
Class
StateMachine
GUIElement
Class

Screen

Class
GUIElement

SUSTATT=TO
19-Jan-13
30-Jan-10
29-Feb-16&
04-Feb-13
29-Feb-16
19-Jan-13
29-Feb-16
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Maintenance Items

Getting to know Maintenance Items

Introducing Maintenance Element Maintenance Items can be used with any element, including
Items Requirements, Components, Classes and other elements to capture problems,
changes, issues, tasks, events and decisions that affect an individual element.
Using maintenance items to track official changes, additions and deletions to sets
of Requirements, Components, User Stories and other specifications provides a
sound basis for overall project governance and traceability.

& @
Decision: Display back order as negative stock
Owner: Greg Michols - || Date: 04,/05/2015 ~  Status: |Verified -
Author: Paulene Dean - | Effective: 16/05/2015  ~ Impact: |Medium ™
Version /10 Copy 1D

Description | History
B/UMAI==x %@

The question had been raised as to how to display items that had zero items in stock but that
had back orders in place. The decision has been made to display the back order quantities as
a negative number, to mark them with an asterisk and to put an annotation on the report
explaining the negative number. "Negative stock numbers indicate total back order
quanitites"

Where to find Ribbon: Construct > Change Management > Features / Changes / Documents /
Maintenance Items Issues / Defects / Tasks

Usage of Maintenance Element Maintenance Items can be used to record a wide range of information
Items about elements including: changes, issues and tasks and more. These can be used
to track the way an element is altered and maintained and can provide information
about the Item including the rationale for the alteration, status and priority. While
the Baseline and Auditing features record what has changed automatically the
Maintenance Items provide the flexibility for a modeler to specify details
manually.

Options for Maintenance There are several types of maintenance item that can be used to add information to
Items elements, including: Features, Changes, Documents, Issues, Defects and Tasks.
Items can present information such as who requested the item, who completed the
item, and the status and priority of the item.

Learn more about Maintenance Items
Maintenance Items
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Mind Mapping Diagram

Getting to know the Mind Mapping Diagram

Introducing the Mind
Mapping Diagram

Where to find the Mind
Mapping Diagram

Usage of the Mind
Mapping Diagram

(c) Sparx Systems 2019

The Mind Mapping Diagram is a useful tool for recording ideas, thoughts and
information in a simple and understandable format. The diagram is a type of spider
(or radial) diagram where a Central Topic or idea is typically located at the centre
of the diagram and Main Topic, Topic and Sub-Topics radiate out as the ideas are
explored and recorded.

Free delivery for
volume purchases
i Hardback and
\ softback options
B ift i
wrapping

Super Express
international

Virtual Titles

deliven

New edition alert

Customer Value

service

Drop-down lists

User and editorial

reviews

Online user library

Map interface for
parcel location

Portable device O

This Mind Mapping diagram shows the use of central

topics, Main topics, and topics to organize thoughts
Pics, Pics, P & 8 Buy back service
priority can be indicated using the order of elements in
! for new titles
the Browser window.

Extra Services

An analyst will often be required to take notes or record ideas (including their
own) and information in the context of meetings, workshops and focus groups.
The Mind Mapping diagram is a useful tool and its simple and appealing layout
makes it accessible to everyone. Regardless of what formal languages or
frameworks are being used to articulate requirements and processes and other
artifacts the Mind Mapping diagram requires little or no explanation.

Ribbon: Design > Diagram > Add > Mind Mapping > MindMapping Diagram

Browser window Toolbar : New Diagram icon > Mind Mapping > MindMapping
Diagram

Browser window context menu | Add Diagram... > Mind Mapping >
MindMapping Diagram

A MindMapping Diagram can be used to record ideas and information in the
context of a workshop, focus group, meeting or even to get your own thoughts
down. It becomes a compelling visual record of the communication and
discussions and often acts as a precursor to more formal techniques such as
requirements articulation, Architecture modeling database design and more.
Requirements and other elements such as Capabilities, Acceptance Criteria, design
Components, User Stories and more can all be traced back to Topics and
Sub-Topics in a MindMapping Diagram.
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Options for the Mind A MindMapping diagram can be made more expressive with the use of images and
Mapping Diagram colors. The appearance of the Central Topic and Main topics could use an image
that visually communicates the central idea. Colors can be applied to communicate
concepts such as the importance or the owner of an idea or any other concept.
Dependency relationships can be added to show how ideas relate to each other; for
example, which stakeholders have specific interactions or which services depend
on other services.

The MindMapping Diagram (like any diagram) can be viewed as an element list
which makes working with the element's properties easier.

X,

Toolbox O

More tools...

4

= Mind Mapping

Central Topic
Main Topic
Topic

Sub Topic

. [ GG G G

Relationship

Diagram Filters can also be used when presenting the diagrams, to draw attention
to parts of the diagrams. The diagrams can be presented as hand drawn or in a
whiteboard style by changing the properties of the diagram.

Learn more about the Mind Mapping Diagram
Mind Mapping Diagram
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Model Mail

Getting to know the Model Mail

Introducing the Model Model Mail is a mail system internal to the Enterprise Architect repository that
Mail allows users to send and receive mail messages. One of the important advantages
that Model Mail has over other mail systems is that it is possible to embed
hyperlinks to parts of the repository, allowing the recipient to click through to the
diagrams, matrices, elements, Packages, reviews and more.

To: Greg Nichols <_gregnichols >, Paulene Dean <_paulenedean = &
Subject: Stakeholder Workshop Diagrams and Matrices
@, Insert Quick Link + Fag: %  Green -
1] a — 1
B JUM|IZ=] ¢ %@
-
Hi Greg and Paulene,
As you know the Stakeholder workshop next week is critical as it is the only opportunity this
month to have all the stakeholders in the same room (lenny and Ming will attend via video
conference). | have attached hyperlinks to the important diagrams and matrices that | think
we should be discussing. Also there is a link to the mind mapping diagram that | will use to
record the decisions in the warkshop.
Diagrams
Current Business Processes Order Management =
Policies and Business Rules
Functional Requirement Feature Traces
Potential Stakeholder Analysis
Matrix
Evaluation Criteria x Solution Options - CRM
warm regards
lane ward
-l

Most initiatives are carried out by a team of people, and critical to their success is
good communication. With a fully featured tool such as Enterprise Architect, it is
typical for team members to perform a lot of their work inside the tool; having
mail internal to the repository provides a lot of advantages. The Model Mail
facility allows team members and others using Enterprise Architect to send and
receive mail messages including hyperlinks to repository content.

Where to find the Model Ribbon: Start > Collaborate > Mail
Mail

Usage of the Model Mail Model Mail can be used to send and receive mail messages internal to the model
allowing team members and other stakeholders to communicate effectively about
the model and its content. A typical scenario might be a team member sending a
message with a link to a set of Requirements to a number of people asking for
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their comments.

Options for the Model Model Mail has the option to insert links to a variety of repository items including:
Mail Diagrams, Matrices, Images, Searches, Help Topics, Attributes, Operations, Team
Library and more.

M 4k M | Mail Inbox ™, Sent Mail

HX ZFRRIE S D-@

Learn more about the Model Mail
Model Mail
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Model Search

Getting to know Model Search

Introducing Model Search The Model Search facility is a powerful and flexible tool for finding anything in
the modeling repository. An object can be located regardless of what a user is
looking for, whether it is the name of an element, text in element notes, a Tagged
Value or properties such as when an element was created, who created it, what its
status is, and more. The facility includes a wide range of built-in searches that can
be used or a user can define their own searches using the Query Builder, SQL
Builder or by defining an Add-In Search.

Find in Project * X
[& Find in Project x q b
Common Searches * | Simple - | warehouse

Drag a column header here to group by that column.

L] Stereotype Status Type Object 2lP|S|C|N
@ Activity Proposed Activity Acquire Forklift 3. P 4,4
@ Activity Proposed Activity Check Stock Availability 1. P 2. 2.
Topic Proposed Class Inter-warehouse transfers performed ... 3. P. 3. 4,
E Functional Validated Issue Leaving out Inventory Domestic Trans... 3. P. 1. 1,
@ Activity Proposed Activity Pick Item 3.0P 4, 4,
’fr_—l Functional Approved Change Pick list order should be controlled b... 3. P. 4, 4,
Functional Proposed Requirement Reduce wasted time sending messag... 1. P. 5. 2,
L4 FunctionalRequirement Validated Requirement REQ1&8 - The solution must allow ite.. 3. P. 1. 1.
FunctionalRequirement Approved Requirement REQ169 - The solution must allow ite... 3. P. 1. 1.
Taopic Proposed Class RFID Inventory Tracking 3. P. B B

With a number of analysts and others working on creating or importing content
into the repository the number of elements will increase rapidly and before long
even with a well organized model it will not be possible to remember where all the
elements are located. The search facility can be used to locate information easily
no matter where it is in the model.

Where to find Model Ribbon: Explore > Search > Model
Search Ribbon: Design > Element > Manage > Search Model
Keyboard: Ctrl+Alt+A

Usage of Model Search The Model Search facility can be used to find anything that exists in the
repository. It can be used to return a set of elements that meet specified criteria for
example in preparation for an iteration to get the list of all Requirements that were
created in the last two weeks that have a Status of Validated and that have a
Difficulty value of Low and a Priority of High. The result set can be sorted,
documentation can be generated and individual elements can be Book Marked, or
located in the Browser window or in all the diagrams in which they appear.

Searches can be used as the basis of a number of other tools such as Model Views,
the Documentation Generator and more.

Options for Model Search A user can choose to use predefined searches or create their own user-defined
searches. Searches can be defined using three different tools: the Query Builder,
which is screen driven and easy for most non-technical analysts to understand; the
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SQL Builder, which uses SQL; or creating an Add-In Search, which requires some
programming.

The Query Builder is the most intuitive of the tools and allows a user to build up
their own query adding one or more filters to restrict the set of elements that will
be returned.

The Search Facility can be configured to query a single Package (and its
sub-Packages if required) or to search the entire Repository.

- I@:I
Edit Motes
CSV Import/Export...

View Motes 4

Import Search
Export Search

Dock in Cutput Bar

Elements returned in the search results list can also be exported to a word
processor or Spreadsheet document.

Learn more about Model Model Search
Search
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Getting to know the Model Transformation

Introducing Model
Transformation

Where to find Model
Transformation

Usage of Model
Transformation

Options for Model
Transformation

Model Transformations are a productivity tool that allow models to be
manipulated to create more specialized or resolved models. The transformations
can be applied to produce a variety of output models including logical and
physical data models, XML Schema models, programming languages and more.
The Model Driven Architecture (MDA) transformations use a flexible and fully
configurable template system.

20 January, 2020

Elements: Transformations:
Element Name Elemert Type | | Name Target Package
- [ cs
O cs+
=| | | vemet 5
[T PHP
Category Enumeration DDL Application Tier
Editarial Review Class [C] EJB Entity
ftem Class [ EJB session
Line ftem Class = [ Java
[T Junit b
Al None [ Include Child Packages 4 I 9

Generate Code on result
Intermediary File (optional for debugging only):

Perform Transformations on resuft

Close

O Wiite Always Wirite Now

Help

Ribbon: Design > Tools > Transform > Transform Selection

Model Transformations can be used as a productivity tool to transform a primitive

model to a more resolved model. There is a wide range of built-in transformations,

including:

e  Generating from a Class model to a programming language model, including
C++, C#, PHP, Java and many more

e  Generating from a Class model to a data model, including ERD, Oracle, SQL
Server, XSD and WSDL models

e  Generating from a Class model to a test model, including NUnit and JUnit test
models and more

Model Transformations are completely configurable using a powerful, simple and
flexible template system. This includes the flexibility to create new user defined
transformations and modify or extend existing ones.
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Learn more about Model
Transformation
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Getting to know Model Views

Introducing Model Views

Where to find Model
Views

Usage of Model Views

Options for Model Views

(c) Sparx Systems 2019

Model Views provide an alternative view of the elements in the Repository.
Whilst the Browser window is designed to organize the Packages and elements
structurally, the Model Views facility allows the modeler to create a number of
views that can group elements and diagrams differently.

The Browser window has been designed to organize the elements structurally,
grouping elements and diagrams together into Packages based on factors such as
namespaces, type of element and the part of the process. Model Views allow a
user to create a structure based on a wide range of criteria including Favorites
folders and folders based on a search such as all elements I created last week that
have a status of 'Proposed'.

Model Views O =
F EE FEaEE ¢ I X@
@ Waorking Sets
= g Model Views
[2] Business Analysis Process
B [=] User Experience
] Features with Contractual Risk
% High Priority Requirements
= [ogl Sales Leads Manager - Android Phone Interface
T3 Strategy Map
£ Order Management
¥a Functional Requirement Feature Traces
Bz Mon Functional
22 Manage Customner Relationships
T3 Personas
Bz UserInterface Prototype
L My Views
& Recent Tearn Reviews

Ribbon: Explore > Portals > Model Views

Model views can be created for a variety of purposes and an experienced modeler
will often use the Model Views facility as the access point to the Repository. The
Favorites folder is useful to keep track of hand picked elements and diagrams of
interest. The Slide show folder is useful to create a diagram slide show for the
purposes of demonstrating diagrams to a group of people in a workshop or
meeting. The Search folder is useful to keep track of elements that meet specified
criteria and to be notified when new elements are added to the Repository that
meet the criteria.

The Model Views root folder defines views that every user can see, whereas the
My Views root folder is only visible to the current user. Both these root folders
can contain any number of user-defined folders down to two levels. User-defined
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folders under the Model Views folder can contain three types of view: Favorites,
Diagram Slide Shows and views based on a Search. User-defined folders under the
My View folders can contain only views based on a Search.

B | % & G e S + 4 I X@

The Model Views window provides a convenient toolbar for working with the
folders and elements.

Learn more about Model Model Views
Views
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Organizational Chart Diagram

Getting to know the Organizational Chart Diagram

Introducing the An organizational model is a powerful tool that is a visual representation that
Organizational Chart describes the roles, responsibilities and the reporting structure of an organization.
Diagram It is invaluable to a Business Analyst as it allows them to visualize and to
understand who they need to communicate with while performing various tasks.
The Organization Chart in Enterprise Architect is flexible and can be used to
create any type of representation including the inclusion of images representing
teams or individuals.

Chief Executive Officer

Chief Finance D:ector o Directorofol Chief Technical Director of
Officer Hman Irectorolade Officer Marketing
Resources
Financial Staff Domestic Sulan Infrastructure
Strategy Recruitment ome Management
Accounts Staff : Research and
— —International Salesf: —
Management Development Development
Customer E
Budget and Operations Y i : Information
— . — — Relationship —
Forecasting Management Management
Management

9

Business Analysis Organization Chart in Sparx Systems Enterprise Architect.

This Organization Chart diagram shows how the organizational structure of an
organization can be represented graphically. Tree Vertical and Lateral Vertical line
styles have been used to lay out the diagram.

Where to find the Ribbon: Design > Diagram > Add > Strategic Modeling > Org Chart
Organizational Chart

. Browser window Toolbar : New Diagram icon > Strategic Modeling > Org Chart
Diagram

Browser window context menu | Add Diagram... > Strategic Modeling > Org
Chart

Usage of the The Organizational Chart can be used to create any type of chart, including a
Organizational Chart Functionally Orientated, Market Orientated or Matrix Model chart. A number of
Diagram charts could be created, representing different current and future states of the
enterprise.

(c) Sparx Systems 2019 Page 91 of 153 Created with Enterprise Architect



Business Analysis Tools - Business Analysis Tools 20 January, 2020

Options for the Apart from the relationships that represent reporting lines in the Organizational
Organizational Chart Chart, Business Analysts can also add relationships of authority, influence, and
Diagram communication, which might not overlay the reporting lines. These additional
lines can be modeled using named Associations and stereotyped if required.

Toolbox O =

Maore tools... | &
= Org Chart
E Role
A Reports To [Vertical Tree)
A% Reports To [Lateral Treg)

1 Communicates with

= Patterns
¥ Org Chart =

The Organizational Chart (like any diagram) can be viewed as an element list,
which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams, to draw attention
to parts of the diagrams; the diagrams can be presented as hand drawn or in a
whiteboard style by changing the properties of the diagram.

Learn more about the Organizational Chart
Organizational Chart
Diagram
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Package Browser

Getting to know the Package Browser

Introducing the Package The Package Browser is a powerful tool that provides a convenient list of the
Browser elements in a Package displayed in a List or a Gantt view. The List view allows a
modeler to work on the elements in the Package in a spreadsheet-like view, editing
properties and notes inline and grouping and sorting the elements. The Gantt Chart
view allows analysts, architects, project managers and others to view the resource
allocation for an element in a convenient and familiar time based view.

Package Browser * X

@ start Page |# Book Store Domain X 4 b

a <« Information Models » Book Store Domain »

Status -~
| Type

| 'lName ~ | Status «T| ype | Modified hd

—| Status: Approved

—| Type: Class =
Reader Review  Approved Class 117208
Review Approved Class 117/2006
Item Approved Class 12/15/2015

—| Type: Enumeration

Category Approved Enumeration 117/2016

—| Status: Proposed

—| Type: Class

Catalog Proposed Class 11/2/2015

Cart ltem Proposed Class 8/17/2015

Address Proposed Class 11/2/2015

Shopping Cart Proposed Class 8/M17,/2015 -

Where to find the Package Select the Package in a diagram or the Browser window
Browser

Ribbon: Design > Model > List View
Context Menu in diagram: Open Package in | List View

Browser window Context Menu: Open Package in | List View

Usage of the Package The Package Browser provides a convenient and alternate view of the elements in
Browser a Package. The list view can be used as a workbench for viewing the elements in

user defined order, changing the elements properties and adding and deleting
elements. The ability to display the elements grouped by various properties and
Tagged Values allows analysis to be performed on groups of elements. The Gantt
chart view provides a project management view of the elements showing how
resources are allocated to individual elements. Reports for all, or a selected group
of elements can be generated.

Options for the Package The Package Browser has two different formats or display options: a User Defined
Browser view and a Hierarchy view. The User Defined view displays all the elements in the
Package regardless of hierarchy. The Hierarchy view arranges the elements in
accordance with the way they are grouped in the Browser window.
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In the User Defined view the items can be sorted in ascending or descending order
by clicking in the column headers. The order of columns can be changed by
dragging column headers left or right. A modeler can drag column headers onto
the View Header (above the column headers), which will group the items in the
list by that property; column headers can be nested in a hierarchy to specify groups
within groups.

[TLL] —
um = —
u
] —
&

" Add New

=@ Print

#

E: Show Mested Package Content
:E'g Show Element Hierarchy

J Show Filter Bar

v | Show Group Bar

Mote Options 4

Learn more about the Package Browser
Package Browser
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Pan and Zoom

Getting to know Pan and Zoom

Introducing Pan and
Zoom

Where to find Pan and

Zoom

Usage of Pan and Zoom

Options for the Pan and

(c) Sparx Systems 2019

Zoom

The Pan and Zoom window is one of the tools that can be used to navigate around
a large diagram. Often, the resolution of a diagram must be reduced to ensure it is
wholly visible, but by using the Pan and Zoom window you can leave the diagram
at a readable resolution and pan around to areas of interest, zooming in when
necessary.

Pan & Foom O x

® Q6 aaq 0

]

Many initiatives will be best described by a number of large diagrams, ranging
from A3 - A0. Even when you are fortunate enough to be using a large monitor,
you will want to change the scale at which you are viewing the diagram and then
pan around to find the section or element of interest in the diagram, and then zoom
into that section. The Pan and Zoom window will allow you to do this for any size
diagram, with tools for panning and zooming that are particularly useful during
workshops or focus groups.

Ribbon: Layout > Tools > Pan and Zoom (Ctrl+Shift+N)

The Pan and Zoom window can be used for moving around and zooming into large
diagrams. A typical scenario could be that an Analyst has created a diagram
showing traceability from Solution Components back through detailed
Requirements and User Stories and Processes up to the level of Business Goals.
This diagram would typically be too large to view at the right resolution even on a
large monitor. The Pan and Zoom window could be used to set the diagram
resolution to a scale that could be easily read and then to pan around the diagram
to elements and areas of interest, zooming in and out as required.

The Pan and Zoom window has a number of options:

® You can pan across the diagram using your mouse pointer to drag the colored
rectangle around to different sections of the diagram
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e  You can zoom into and out of the diagram either using the Slider control to
change the scale of the diagram, or using the tool icons to:
- Zoom In
- Zoom Out
Zoom to fit diagram
Zoom to fit page
Zoom to 100%

®eeaaq U

Learn more about Pan and Pan and Zoom
Zoom
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Project Management Items

Getting to know Project Management Items

Introducing Project Project Management Items allow a modeler to define useful information about an

Management Items element from the perspective of the management of the element. These include the
Resources that can be allocated to work on the element, the Effort required to
complete work on the element, Metrics that capture valuable information about a
property of the element, and Risks associated with the element.

Where to find Project Ribbon: Construct > Resource Management > Resources
Management Items  piphon: Construct > Project Management > Effort, Risks, Metrics
Element tab of the Browser window : Project | Effort, Risks, Metrics

Element tab of the Browser window : Resources

Usage of Project Project Management Items can be added to assist in the management of a project.
Management Items Specifying the resources that can be allocated to work on a particular element will
assist with ensuring the right resources can be scheduled to carry out the work.
The Effort required will also help in specifying exactly what resources will be
required. The Metrics can provide useful and structured information about
properties of the element such as the cost and time estimations. Risks can be
defined that will assist in the overall management of project risks.

Options for Project Project Management Items can be applied to any element in the Repository,

Management Items including Packages, which is useful if a manager wants to assign an item such as
Resource Allocation to a number of elements such as a group of Non Functional
Requirements.

HEBE X s ke

There is a convenient toolbar that allows you to manage any of the Project
Management Items, with icons for New (Item), Save, Delete, Sort and more.

Learn more about Project Project Management Items
Management Items
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Relationship Matrix

Getting to Know the Relationship Matrix

Introducing the
Relationship Matrix

Where to find the
Relationship Matrix

Usage of the Relationship
Matrix

Options for the
Relationship Matrix
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The Relationship Matrix is a tool for visualizing the way that Requirements are
related to each other and to other elements in the model in a visually compelling
view resembling a matrix or spreadsheet. It can be used to view the relationship
between Stakeholders and their Requirements, how Use Cases are related to
Business Requirements or Functional Requirements, how Capabilities are related
to Business Drivers, which Components implement a set of Requirements, and
more. Any number of matrices can be defined quickly and then saved to be viewed
in workshops or included in documentation generated automatically from the
model or exported to a spreadsheet file. When a matrix is created, connections can
be viewed by placing the Requirements on one axis of the matrix and the
connected elements on the other axis, then the cells of the matrix will indicate the
direction of the relationship.

Target + |

REQD14 - Process Credit Card Payment

REQ011 - Manage User Accounts
REQD18 - Report on User Account

REQD12 - Provide Online Sales
REQD13 - Manage Deliveries
REQ014 - ShoppingBasket
REQD189 - Manage Inventary
REQO21 - List Stock Levels

REQO16 - Add Users
REQO17 - Remove Lser
REQO20 - Receive Books
REQO22 - Order Books

+ | Source
Add Mew Titles

Add To Shopping Basket

=

Close Account T

Create Account T

Create Orders T

Delete User T

Browser window | Right-click on Package | Relationship Matrix | As Source.../As
Target.../As Both...

Resources Window: Matrix Profiles

To display the relationships that exist between elements - such as which
Requirements are realized by which Use Cases - in two Packages in a visually
compelling matrix. It is useful in analyzing missing elements or relationships; for
example, to determine which Requirements are not realized by any Use Case, or
which Components do not have corresponding Requirements or Use Cases. It is
particularly useful in workshops with Business Stakeholders who might not be
familiar with seeing Requirements in Trace diagrams.

There are a range of options that can be set for the matrix including saving it to the
Resources window or to a CSV format for opening in a spreadsheet. The
appearance of the matrix can also be altered by sorting the elements, showing an
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outline numbering view, and suppressing Package names. These items are
available from the Options button on the Relationship Matrix.

- Options
Scale Setting Matrix 3
Print Profiles 3
Print Preview Options

@ Hel

Save as Metafile @ P
Save as PNG
Export to C5V...

Learn more about the Relationship Matrix
Relationship Matrix
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Requirement Properties

Getting to Know the Requirement Properties

Introducing Requirement Requirement Properties are used to define metadata about the requirement that is
Properties useful for the management of requirements for the purpose of prioritization and
defining work Packages for the implementation teams. All Enterprise Architect
elements have standard properties such as Status, Author and Phase but the
Requirement element has additional properties such as Difficulty and Priority.
User defined properties can also be defined using Tagged Values.
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Where to find
Requirement Properties

Properties O x
d =-
Element Tags
Name req-029
4 General
Type FunctionalRequirement
Stereotype EAREQ::FunctionalRequirement
Alias
Keywords
Status Proposed
Version 1.0

FunctionalRequirement ( from EAREQ )

Priarity
dataDescription <MEemo=
operationDescription  <memao>
workflowDescription  <memo>
reportDescription <Memo=

4 Requirement
Abstract |
Active [l
Difficulty Medium
Final Specialization [ ]
Leaf
Priority Medium
Visibility Public

4 Project
Author hbritten
Package
Phase 1.0
Complexity Easy
Created 4/09/2019 4:31:58 PM
Modified 4/09/2019 4:31:58 PM
Language <none=
Filename
GUID {B0170961-E1FE-4928-BDFE-854BE0EDGADG}
WebEA

Ribbon: Design > Element > Editors > Properties

Element Context Menu: Properties... | Properties...

(c) Sparx Systems 2019
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or

Browser window Context Menu: Properties | Properties...

Usage of the Requirement To define the important meta information about a requirement, for the purposes of
Properties providing data to manage the requirements for prioritization, understanding which
are the difficult requirements, and managing the lifecycle by using Status to
determine requirements for implementation Packages.

Options for Requirement Enterprise Architect has a wide range of built in properties for all elements but it
Properties has a number of additional properties for requirements. If there are other
properties that are needed by a modeler or team such as the volatility (stability) of
a requirement these can be added using the general purpose UML extension
mechanism of Tagged Values.

REQD21 - List Stock Levels

.
tags

Vaolatility = Medium

Learn more about Properties Dialog
Requirement Properties
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Requirements Checklist

Getting to know the Requirements Checklist

Introducing the
Requirements Checklist

Where to find the
Requirements Checklist

Usage of the Requirements
Checklist

Options for the
Requirements Checklist

Learn more about the
Requirements Checklist
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The Requirement Checklist is a convenient element that acts as a tally to indicate
whether a Requirement complies with a set of predefined measures such as
whether the Requirement is Atomic, Cohesive, Traceable and Verifiable. It can be
assigned to any Requirement and the measures can be updated directly in the
diagram. When working with requirements it is sometimes very useful to refer to a
common set of 'best practices' and qualities that help define the nature of a well
formed specification. The Requirement Checklist element is designed to meet this
need.

O

This diagram shows the use of a
Atomic Requirements Checklist that acts as
anindicator (check) to ensure the
requirement is compliant with best
practice. The check items are
editable and a general checklist
Current element is available that can be
used with any element.

Requirements Checklist

he system must
echanism allowing

identify themselves
Attainable

Cohesive
Complete

Independent
Modifiable
Traceable
Unambiguous
Verifiable

HOMORROEEE

Toolbox : L to display the 'Find Toolbox Item' dialog and specify
'Requirements Checklist'

Analysts and Requirements Managers can use the checklist to annotate whether
one or more elements such as a Block or Activity or even a set of Requirements
meet a set of predefined checks.

The list of measures is completely configurable and items can be added or
removed from the list for each individual checklist by using the Checklist Tagged
Value notes.

“Cheddist=
<Item Text="Atomic™ Checked="True"/=
<Item Text="Attainable™ Checked="True"/=
<Item Text="Cohesive"” Checked="False"/>
<Item Text="Complete” Checked="False"/>
<Item Text="Current” Checked="True"/=
=Item Text="Independent” Checked="False"/=
<Item Text="Modifiable” Chedked="True"/=
=Item Text="Traceable” Chedked="True"/>
<Item Text="Unambiguaus” Checked="True"/=
<Item Text="Verifiable™ Checked="True"/=»

= Chedkist =

Requirements Checklist
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Requirements Diagram

Getting to Know the Requirements Diagram

Introducing the
Requirements Diagram

Where to find the
Requirements Diagram

Usage of the Requirements
Diagram

Options for the
Requirements Diagram

The Requirements diagram provides a visual representation of how Requirements
are related to each other and to other elements in the model, including Business
Drivers, Constraints, Business Rules, Use Cases, User Stories, design Components
and more. The diagram is one of Enterprise Architect's extended diagram types
and for analysts who are accustomed to working with Requirements in a text based
tool it will provide a welcomed and compelling graphical representation of the
Requirements.

re and Manage Books E O

This diagram shows a Use Case that
realizes a requirement. The realized
requirement is part of a hierarchy of
requirements expressed with the
Aggregation relationship. The Use
Case has an annotation under the

? element indicating its package location

age and management
be required.

in the Browser window.

d Books E

| be required to receive and
o the stock lists.

|
«realize»

New Titles

(from Manage Inventory)

Browser window Context Menu : Add Diagram : = | Manage | Show All
Perspectives | Extended | Requirements

One usage is to show how Requirements are connected together in a hierarchy, but
a more compelling usage is to show how requirements are connected to other
elements. The experienced modeler will define and manage the requirements in
the Specification Manager and then use the Requirements diagram to show how
one or more requirements are related to up-process elements such as Business
Drivers and down-process elements such as Use Cases, User Stories, User
Experience designs and solution Components.

The appearance of a diagram can be changed to suit the audience, and details can
be included, suppressed or altered to ensure the diagram meets its main objective
of communication. There is a wide range of options, ranging from creating a Hand
Drawn style of diagram to filtering diagram content.
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=

4

Properties

=-H

Diagram Compartments

General

MName

Type

Stereotype

Author

Applied Metamodel
Filter to Metamodel
Filter to Context
Context Navigation
Version

Version

Filter to Version

Mew to Version
Appearance

Display as

Hand Drawn
Whiteboard

Custom Style

Disable fully scoped object names
Display Element Lock 5tatus
Use Info Tip (global)
Theme

Advanced

MDG Technology

GUID

WebEA

Connectors

Show Relationships
Show Mon-Mavigable Ends
Show Property 5tring
Suppress All Labels
Show Stereotype Labels
Show Feature Linker

Connector Motation

Requirements Model

Requirements

hbritten
Default

O

b

ooz

Diagram

O
0
0
O
0

LIse global theme

Extended::Requirements

{82528010-B2FA-4314-A1ED-2...

Kl & OR O E

[

ML 2.1

Learn more about the

Working In Diagrams

Requirements Diagram

(c) Sparx Systems 2019

Page 106 of 153

Created with Enterprise Architect


http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/modeling_tools/commondiagramtasks.html

Business Analysis Tools - Business Analysis Tools 20 January, 2020

(c) Sparx Systems 2019 Page 107 of 153 Created with Enterprise Architect



Business Analysis Tools - Business Analysis Tools

Risk Taxonomy

Introducing the Risk
Taxonomy

Where to find the Risk
Taxonomy

Usage of the Risk
Taxonomy

Options for the Risk
Taxonomy
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Getting to know the Risk Taxonomy

The Risk Taxonomy is a facility to define a comprehensive, stable and reusable set
of risk categories that can be applied universally across the system. This includes
definitions of Threats, Loss type, Contact Frequency, Loss Magnitude, Risks and
more. It is based on the Open Group Standard for Risk Taxonomy (OR-T) and
provides a toolbox and diagrams for defining the Taxonomy.

Risk Taxonomy

The UML Profile for Risk Taxonomy provides support for modeling risk scenarios

and analyzing risk conditions.

The Risk Taxonomy profile provided by Enterprise Architect supports the Open Group

Standard for Risk Taxonomy (OR-T), version 2.0. O

Risk Taxonomy and Risk Analysis diagram in
Sparx Systems Enterprise Architect

This Risk Taxonomy Diagram shows the use of
elements to model risk in a formal way
including the Risk Scenario, Threat
Communities, the frequency of the threat, the
Threat Community's capability and the
strength of the controls. Vulnerability can then
be derived from these other factors.

Risk Taxonomy diagrams and their associated toolboxes are available from the
Risk Taxonomy category.

Scenario»
nd Password left
by Warehouse

«ThreatCommunity»
Contract Couriers

tEventFrequency»
High

nceStrength»

that the contractors access only need to
acity to read the
on the sticky
ealize that they
als.

als are written in
an unencrypted
there is little
ngth.

ore than 360 times a year
daily) and they know the
e credentials to access
ermine valuable stock

Ribbon: Design > Diagram > Add > Risk Taxonomy > Risk Taxonomy

Browser window Toolbar : New Diagram icon > Risk Taxonomy > Risk
Taxonomy

Browser window context menu | Add Diagram... > Risk Taxonomy > Risk
Taxonomy

The Risk Taxonomy provides a common language and references for security and
business analysts who need to understand and analyze risk in a formal way. It
allows analysts to estimate the probable frequency and magnitude of future loss.

The Risk Taxonomy can be used at varying levels of formality depending on the
initiatives, processes and requirements for risk assessment. The Relationship
Matrix could also be used to record the relationship between the discrete values,
Threat Capability and Resistance (Control) Strength to determine the derived
Vulnerability. A Toolbox of elements and relationships is available for the Risk
Taxonomy diagram allowing sophisticated models of risk to be created.
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Learn more about the Risk
Taxonomy

Toolbox

O

Mare tools...

[l Risk Taxonomy
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Asset Loss

Assumption

Contact Frequency
External Loss

Loss

Loss Event Frequency
Loss Magnitude
Organizational Loss
Probability Of Action
Resistance Strength
Risk Scenario

Rizk

Risk Management Decision
Threat

Threat Agent

Threat Capability
Threat Community
Threat Event Frequency
Threat Response
Vulnerability

[l Risk Taxonomy Relationships

|
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Affect

Deny Access
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Risk Taxonomy
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Roadmap Diagram

Getting to know the Roadmap Diagram

Introducing the Roadmap The Roadmap diagram is an overlay that can be applied to any diagram to describe
Diagram significant phases in elements and how they change with the passage of time.

Unit: Quarterly Component Lifecycle

| Q412 | Q13 | Q213 | Q313 | Q413 | Q114 | Q214 | Q314 | Q414 | Q115 | Q215 | Q315 | Q415 | Q116 | Q2'16 | Q316 | Q416 | Q117 | Q217 | Q317 | Q417 | Q118 | Q2
ettt et bttt et r bt rbr et e rrtrr b

CE—— | e — | |
| == | |
| | — | |

The The two

replacement | | applications

CRM system (incumbent

will be and the

implemente replacement

dand during | |) will be run

this period in parallel O Legend
adapterswill | |for This diagram shows ®

be approximate the use of a (] mtementation
configured ly 4 weeks or roadmap overlay to ) oeioomeet

to ensure until the present the lifecycle @ ssvoredray
data is replacement phases of the [ et
exchanged component Customer O supmnentotre
with a can be fully Relationship

number of evaluated. components

other existing and

systems. incumbent systems

and the ERP system
which it interfaces
to for sales figures.

L e e A A O I I OO A
Q472 QI3 Q213 Q313 Q413 Q4 Q214 Q314 Q414 Q15 Q215 Q315 Q415 QI16 Q216 Q316 Q416 Q17 Q217 Q317 Q417 QI8 Q2%
Unit: Quarterly Component Lifecycle

There is no restriction on the type of element that can appear on the diagram, and
any diagram can have a Roadmap overlay defined. Significant user defined phases
in the element's lifetime are represented by colored bars, which can be set to show
duration. The colors and the phases can be configured using a Diagram Legend,
which automatically applies them to the elements in the diagram. They are
particularly useful in Enterprise Architecture diagrams for describing capability
and application Roadmaps.

Where to find the Ribbon: Layout > Diagram > Roadmap

Roadmap Diagram  pjoram Context Menu: Roadmap

Usage of the Roadmap The Roadmap diagram has a wide range of uses in Enterprise Architecture where
Diagram they can be used to show application and capability roadmaps to Systems
Engineering, where they are used to show timing in low level components.

Options for the Roadmap The Roadmap overlay has a range of options that determine the properties of the
Diagram timeline, such as the scale of the time rulers, units, their positions, and the
appearance of the time line including fonts and colors. The height and position of
the timeline can also be configured to suit the diagram and display.
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Learn more about the
Roadmap Diagram

-

Roadmap opticns

Enabled

- Timeline Properties
Roadmap Title: | Product Lifecycle

nits: Quarterhy -

Tick spacing: _G

Timeline Start: 01/10:2015

Timeline End: [17/08/2015

|Use legend for phase colors

Scale: Marker offset: Tichks:

- Timeline Appearance

Roadmap Position: | Top

Timeline Height: G

Timeline Color: R

Line Color: | B Lines at major intervals
Fart: A Certer marker labels

QK Cancel

Help

The Diagram Legend can be configured to define the phases in the elements
lifetime and to set the specification of the colored bands and more. Roadmap
segments can be shown or hidden on individual elements in cases where a
particular segment might not apply to one or more of the elements on the diagram.

Roadmap Diagram
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Getting to Know the Scenario Builder

Introducing the Scenario
Builder

Where to find the Scenario
Builder

Usage of the Scenario
Builder
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The Scenario Builder is used to define the details of a Use Case including defining
detailed descriptions, creating one or more Scenarios and defining pre-conditions,
post-conditions and other constraints. The detailed steps of a Use Case can be
recorded and linked to other elements in the model and these can then be
generated out as a diagram providing a visual representation of the Use Case and
its Scenarios. The diagram and the text can be synchronized and individual steps
can then be traced to other elements such as Components that will realize the
Requirement specified in the Use Case.

Scenarios o x

Type: Scenario:
Basic Path - | | Basic Path -
A T +4 B-v- X @
Step Action Uses Results State

% 1 The User selects the option List
Stock Levels

The System displays a List of Stock
Items

% 3 The User selects multiple items in
the list

4 The User submits the selection

5 The System displays the Stock Levels

0 e

| -
Entry Points | Context References | Constraints

Ld Name Type Connection Comment Package

> Use Case C UseCase Generalization Use Cases

REQOZ21 - List 5tock Levels Requirement Realization

N

Requirements

Element Context Menu: Properties | Scenarios

To define the details of a Use Case and its scenarios and constraints, which can be
used to replace the traditional text-document based approach to defining Use
Cases. This ensures that the Use Case diagram and the textual details of the Use
Cases and its Scenarios and Constraints are all contained in the same model and
can be traced. If the Use Cases are required in a document format for contractual
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or process reasons, a Use Case Report can be generated automatically from the
models using the in-built documentation engine.

Options for the Scenario The Scenario Builder can be viewed as a tabbed or a docked window or in an
Builder element's Properties window. The steps of a Use Case including its Scenarios can
be automatically generated into a number of different diagram types available
from the Generate Diagram toolbar icon.

B-v-IX@
Activity
Activity with ActivityParameter
Activity with Action
Adtivity with ActionPin

RuleFlow

State

Sequence

Robustness

Learn more about the Responsibilities
Scenario Builder
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Schema Composer

Getting to know the Schema Composer

Introducing the Schema
Composer

Where to find the Schema
Composer

Usage of the Schema
Composer

Options for the Schema
Composer

Learn more about the
Schema Composer

(c) Sparx Systems 2019

The Schema Composer is a powerful and productive tool for working with
information that is shared between organizations or within organizations. Many
industries, domains and organizations have defined a shared information model or
schema and mandate or encourage parties to use this model when sharing
information. The Schema Composer is a tool that helps analysts and others to
define messages that comply with the schemas and thus comply with the mandated
formats.

Profile

Fassport ..| [SchemaType | Schema -
Schema Set Core Compenents (UN/CEFACT) - NDR 2.0 Address has 5properties

referenced by: Person Residence

New » Generate | Modzl Ref B irined 0 times, refersniced 1 times and inherted:0times
Namespace  hitp://myauthorty crg/passports
Namespace Pr... rsm
Unfied Schema e =
Classes Atibutes Schema
= Address Address 5 {y Passport

= Count
g 3 Address Attributes = Address

5 Decimal

5 WyCode BuildingNumber - MyText
CityName - MyText

= Myldentier CountryName : MyText

5 MyMeasure Fostcode : MyCode

5 MyText StrestName - MyText

5 MyDateTime

Ribbon: Develop > Schema Modeling > Schema Composer > Open Schema
Composer

The Schema Composer can be used to work with a number of standards including:
e The Common Information Model (CIM)
e National Information Exchange Modeling (NIEM)

e  United Nations Center for Trade Facilitation and Electronic Business
(UN/CEFACT) Modeling Methodology (UMM), specifically the Naming and
Design Rules (NDR) 2.1 and 3.0

e  Universal Business Language (UBL), specifically the Naming and Design
Rules (NDR) 3.0

A modeler can however define their own schema using the tool either for use
within an organization or as part of a standards or technical committee. Other
standards will be added as more agencies and industry groups adopt the tool.

The Schema Composer can also be used to create a definition of the same message
using a number of different formats such as:

e  XSD - (XML Schema Definition)
e RDEFS - (Resource Description Framework Schema)
e JSON - (JavaScript Object Notation)

Schema Composer
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Security

Getting to know Security

Introducing Security The Security system in Enterprise Architect is designed to facilitate collaboration,
not as a barrier to incursion.

The information contained in the Repository is a valuable organizational asset that
needs to be maintained and secured as such. The asset must be protected from both
intentional and inadvertent compromises of content. The Security system allows
update functions to be restricted to a set of users or groups with the appropriate
defined permission. Packages, elements and diagrams can be locked by users,
preventing others from updating them.

User Details User Groups
Login: paulinedean [ Administrators
Firstname: Pauline Sumame: | Dean [l ibrarians
Modelers
Department: Business Analysis [ viewers

Add Userto Authors

[[]] Accept Windows Authentication

Users: New

Sumame Firstname Login
Administrator The admin

Dean Pauline paulinedean
Howard Tim timhoward
Michols Greg gregnichols
Miglsen Ken kenniglzon

Where to find Security Ribbon: Configure > Security

Usage of Security Security has been designed to restrict access to update functions to groups and
users who have been granted the access permissions to perform these functions.
Packages, elements and diagrams can also be locked for change by a user under a
single user ID or group user ID, preventing others from changing them. The
Security system has been designed primarily to facilitate collaboration and cannot
be used to restrict users from viewing parts of the model.

Options for Security Security itself is optional in Enterprise Architect, and by default is not enabled. If
it is required, security can be enabled and a security policy can be set. There are
two policies that can be set to dictate the way security functions:

1. Require User Lock to Edit - (More Rigorous Policy) the whole project is
locked against editing and the user must deliberately lock an element to be
able to edit it.

2. User/group locking - (Less Rigorous Policy) the whole repository is unlocked.
When a modeler edits an element or diagram the element or set of elements is
automatically locked, preventing others from editing them.
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Manage Users...
hManage Groups...

Manage Locks...

Require User Lock to Edit
Apply Locks to Connectors

Manage My Locks... Ctrl+=5hift+L

Login as Another User...

Change Password...

# | Enable Security...

Any number of users and groups can be defined. Users can be given individual
permissions and also placed into one or more groups that have additional
permissions defined. The set of permissions for a user is the sum of their
individual permissions plus those of any groups they are assigned to. Users can be
defined manually or imported from Windows Active Directory, allowing single
sign-on using Windows Authentication.

Learn more about Security Security
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Sequence Diagram

Getting to know the Sequence Diagram

Introducing the Sequence The Sequence diagram is one of the Unified Modeling Language (UML)

Diagram Behavioral diagrams that can be used to define the time ordered flow of messages
between elements. They can be used by business and technical users but are more
commonly used for technical descriptions of a system. Time is by convention
represented on the vertical axis and elements (Classifiers or Instances) are
positioned horizontally at the top of the diagram. Commonly an Actor
(representing a role played by a user) starts the flow and messages are passed
between the elements showing how a result is achieved.

Contacts Manager

Accounts Manager

Iy 1.0 getAddressesList(int): AddressList

First the list of current I VLTJ I
addresses s retrieved I

Iy 1.1 addAddress(String): Strin i
Next the new address is I - (String): String o

| =
added. Iy Qi

O

This sequence diagram show the how components
communicate. The components have a number of structural
features: each has a port (ai = address interface) and an
interface (Address). The interfaces have services defined that
can be used as the operation for the message.

Where to find the Ribbon: Design > Diagram > Add > UML Behavioral > Sequence

Sequence Diagram g,y et window Toolbar : New Diagram icon > UML Behavioral > Sequence

Browser window context menu | Add Diagram... > UML Behavioral > Sequence

Usage of the Sequence The Sequence diagram can be used to model any set of messages that flow

Diagram between two or more elements to produce a result. They are more typically used
by technical modelers to depict how messages are passed between application
components and interfaces to achieve an outcome. They are particularly useful
when used to describe complex protocols or subsystem interactions that are
difficult to understand unless presented graphically. Sequence diagrams can also
be created automatically from stack traces as a way of visualizing how a system
functions.

Options for the Sequence The elements that appear in Sequence diagrams can be either Classifiers such as
Diagram Classes and Components or instances such as Objects and Component Instances.
The choice will depend on what the modeler wants to represent. The order of
objects and messages can be altered to make the diagram more readable and notes
can be used to explain parts of the diagram. Fragments can also be added to
represent control structures that operate on a group of messages.
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Learn more about the Sequence Diagram
Sequence Diagram
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Specification Manager

Getting to Know the Specification Manager

Introducing the The Specification Manager is the central tool for working with Requirements; it
Specification Manager provides an interface resembling a Word Processor or Spreadsheet tool for

entering, maintaining and viewing Requirements. New Requirements can be
created with names and detailed descriptions and properties such as Status and
Priority can be added from drop-down lists. Existing Requirements can be viewed
and managed in a convenient view, and changing them in the Specification
Manager will change them in all other places in the repository such as diagrams
and windows. It is the perfect tool for those analysts more comfortable working
with text rather than diagrams and who are accustomed to working in a Word
Processor or Spreadsheet. It has the added advantage that the requirements are part
of a model and can be traced to other elements, including Business Drivers,
Stakeholders and Solution Components.

Item

1 REQO19 - Manage Inventory

The system MUST include a complete inventory management facility to
store and track stock of books for the on-line bookstore.

1.1 REQ122 - Inventory Reports

Inventory reports are required that detail the available stock for each
item including back orders. Future stock level reports should be able
to predict the quantity of stock at a specified future date.

1.2 REQO23 - Store and Manage Books

A book storage and management facility will be required.

1.2.1 REQOD22 - Order Books

A book order facility will be required to allow on-line ordering
from major stockist's.

1.2.2 REQO21 - List Stock Levels

A facility will exist to list current stock levels and to manually
update stock quantities if physical checking reveals
inconsistencies.

Where to find the Browser window | Right-click on Package | Open Package in | Specification
Specification Manager Manager

Usage of the Specification To create, view and maintain Requirements in a text based tool that resembles
Manager working in a word processor or spreadsheet. Details can be added to the
Requirements and Requirement properties can be added from drop-down lists.
When the Requirements are changed in the Specification Manager the changes are
conveniently reflected in the Browser window and all other windows.

Options for the There are a wide range of options available from the options menu, to tailor the
Specification Manager way you use the Specification Manager. These include Level (hierarchical)
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Numbering, Auto Naming, Spell Check, Documentation, Import and Export of
Requirements, access to various related tools and more.

Specification Package
Default Specification Type
Open Relationship Matrix
Specification Review

Specification Management

Documentation and QA

Appearance 3

Learn more about the The Specification Manager
Specification Manager
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StateMachine Diagram

Getting to know the StateMachine Diagram

Introducing the
StateMachine Diagram

Where to find the
StateMachine Diagram

Usage of the StateMachine
Diagram

Options for the
StateMachine Diagram

The StateMachine diagram is one of the Unified Modeling Language (UML)
Behavioral diagrams that can be used to model the important phases in the lifetime
of an element. It is often thought of as a diagram for technical uses but it has equal
applicability for non technical audiences. The StateMachine is defined for a
selected entity in the system and a perspective is defined that will be modeled by
the States and other elements and connectors in the diagram.

stm Manage Titles State

In Catalogue \'

Order [qty <= stock]

k Released

addToCatalogue OnOrder In Stock
received

P,
Q

This state machine illustrates
composite states - inwhich a
super state has nested sub
states to show the detailed level
of states that can exist within the

super state. removeFromCatalogue

Removed from Catalogue

Ribbon: Design > Diagram > Add > UML Behavioral > StateMachine
Browser window Toolbar : New Diagram icon > UML Behavioral > StateMachine

Browser window context menu | Add Diagram... > UML Behavioral >
StateMachine

The StateMachine diagram is used to model the important phases in the lifetime of
a system entity. It can be used to model business entities such as Bank Accounts or
technical entities such as a Traffic Light Control system.

The StateMachine diagram can be automatically converted to an analogous model
in a State Table Editor. This can be an appealing representation for some users and
the editor provides an easy to use interface to add new States and Transitions.
StateMachine diagrams and Tables can be used to create Model Simulations that
will allow the modeler to visualize, explore and test the dynamic behavior of the
StateMachine.

StateMachines can also be used to generate code into Hardware Description
Languages (HDL).

(c) Sparx Systems 2019
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Learn more about the
StateMachine Diagram
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Toolbox 0O x
More tocls... |-

= State

State

State Machine

Initial

Final

History

Synch

Chject
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Junction
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Terminate
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Fark/loin

— | x@CcecHUED®e b

[=] State Relationships
A Transition
BR Object Flow
=  Additional
HE Event

Signal
[ Trigger

The StateMachine diagram (like any diagram) can be viewed as an Element List,
which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention
to parts of the diagrams and the diagrams can be presented as hand drawn or in a
whiteboard style by changing the properties of the diagram.

StateMachine Diagram
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Stereotyping

Getting to know Stereotyping

Introducing Stereotyping Stereotypes are one of the Unified Modeling Language Extension Mechanism that
can be used to create a new type of element based on an existing UML element
type. There are many cases where things of interest in a particular industry or
domain would benefit from being defined as a type. The stereotyped elements
often add clarity to a model and are meaningful to a model audience who is
familiar with their domain. Examples include a 'contract' stereotype in the legal
profession, a 'policy’' stereotype in the compliance profession or a 'meter’
stereotype in the energy distribution industry.

Stakeholder Requirements

This diagram shows a number of stakeholders and their needs (requirements).

Astereotype has been created for the stakeholders, that has an alternate image assigned to it.
The requirements are displayed using a rectangular presentation style, so as to display the
stereotype <<stakeholder requirement>> in the diagram.

«stakeholder requirement» D
REQ118 - The solution must reduce the
need for paper records to be created

and kept.
Operations

Manager

requirement» D
n must comply with

er experience and
standards

Customer «stakeholder requirement» D

Experience REQ120 - The solution must support
Manager internationalization as prescribed in the

global enterprise policies document

«stakeholder requirement» u:]
REQ121 - The solution must result in
increased revenue in the second year of

operation
Chief

Financial
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fragmentation of meaning and also can result in models that are not understood by
external audiences.

Options for Stereotyping Stereotypes can have a number of appearance settings applied that help to
distinguish the element type. These include changing the default colors of the
element, or changing the appearance by assigning an image or a new shape to
elements with the applied stereotype. The image is best defined in a vector format
such as a metafile, so that when it is resized the image doesn't become pixilated. A
Shape Script can be defined that uses a user defined script to draw the element,
effectively allowing any style of element to be drawn and conditionally adding
graphic features based on properties and Tagged Values.

Ctersotype: | stakeholder

Group name:
Base Class: |clgss =
Motes: A stalceholder is a group or person who has

interests that may be affected by an initiative
or who have influence over the inttiative.

Cryemide Appearance I}

"1 None
© Metafile Assign Remove
"1 Shape Script

Default Colors Preview

Fill: [IDe..[=

Border: |l De... [~

Font: [ e

Heset

Learn more about e  Stereotypes
Stereotyping o gtereotype Settings

(c) Sparx Systems 2019 Page 124 of 153 Created with Enterprise Architect


http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/model_domains/stereotypedlg.html
http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/model_repository/stereotype_settings.html

Business Analysis Tools - Business Analysis Tools 20 January, 2020

Strategy Map

Getting to know the Strategy Map

Introducing the Strategy A Strategy Map is a diagram that is used to describe the primary strategic goals
Map that are important to an organization or business team. The diagram shows four
important perspectives that are the significant questions that provide the definition
of a strategy. The most commonly defined perspectives are: ‘Financial’,
‘Customer’, ‘Internal Business Processes’, ‘Learning and Growth’. The diagram is
used as a communication device to ensure there is a common understanding of the
strategy, to focus organization effort and to assist with the assessment of progress.

Financial Perspective

(ong-Term Shareholdel
Productivity Strategy Value

/'

Increase Asset
Utilization

Growth Strategy.

Expand Revenue
Opportunities

Enhance Customer

Improve Cost Structure, Value

Customer Perspective

Customer Value Proposition

Price Consistent Quality High Availability Titles Selection Service Excellence

ad

Internal Perspective /

ns Management
rocesses

Partnership

Product or Service Attributes Relationship

0

Learning and Growth Pdrspective

Human Capital

T i i i
Information Capital

e e o o
Organization Capital

Culture Leadership Alignment Teamwork

Where to find the Strategy Ribbon: Design > Diagram > Add > Strategic Modeling > Strategy Map

Map Browser window Toolbar : New Diagram icon > Strategic Modeling > Strategy
Map
Browser window context menu | Add Diagram... > Strategic Modeling > Strategy
Map

Usage of the Strategy Map The Strategy Map is used to model the key strategic goals that an organization or
management team intend to achieve. Elements in each of the four perspectives can
be linked to other elements in the repository to show how they could be
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Options for the Strategy

Map

Learn more about the
Strategy Map

(c) Sparx Systems 2019

implemented at a business, application or technology level.

A Strategy Map can be created using Patterns that automatically create elements
and a diagram that can be used as a starting point for the Strategy Map. There are
three Patterns available, ranging from a very simple expression with a single
element in each perspective to a completely worked expression with multiple
elements in each perspective. A toolbox provides a range of additional elements
and relationships to extend the base maps created using the Patterns.

Toolbox O =
More toals... |&
= Strategy Map
[, Perspective
Mission
Vision
Attribute

Initiative

Intangible Asset
Objective

Theme

Category

Family

Process

Proposition
Strategy

Activity

Cause & Effect Flow

Elve MUMMLOGGCOOC O M m

Group

El  Patterns
¥3 Strategy Map1
v3 Strategy Map 2
¥3 Strategy Map 3

Strategy Map
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Tagged Values

Getting to know the Tagged Values

Introducing the Tagged Tagged Values are one of the Unified Modeling Language's built-in extension
Values mechanisms. They provide a useful and productive way of adding extra properties
to elements, attributes, operations or connectors; just as you would add an
additional column in your favorite spreadsheet. They have a Tag name and a
Value, and additional Notes. You can use a wide range of user interface controls to
assist users when entering a value for the tag, such as drop downs, spin controls,
date and color pickers, and more.

Tagged Yalues o x
M@=l a: ~o [P
ENCR X D@

B UseCase (As a Stock Control Manager | want to be able to list stock levels for a selection of titles)

Violatity High =
High
Low |

There are a variety of properties available for elements in the Repository,
including name, notes, status, author and version. Even with these properties
available, it is likely that an analyst will need to add additional properties in some
situations, and the Tagged Values facility is an easy to use and productive
mechanism for working with these properties.

Where to find Tagged Defining Tagged Values
Values Ribbon: Configure > Reference Data > UML Types > Tagged Value Types

Using Tagged Values
Ribbon: Start > Desktop > Design > Properties > Tags

Usage of the Tagged Tagged Values are additional properties (and their values) that can be set for any
Values UML element, attribute, operation or connector. For example a Requirement
element does not have a built in property for volatility and so a Tagged Value
could be added providing the user with a drop down list of available values: such
as High, Low, Medium.

Tagged Values are used extensively in profiles and technologies. For example you
will use them when working in the BPMN Technology to set properties of
Activities or in the Wire Framing Technology to show or hide phone menu buttons
and notification bars.

Options for the Tagged There are built in Structured Tagged Value Types that help the user when entering
Values the value for a tag. The values can be restricted using user interface controls such
as drop down lists, spin controls, date selectors and many more.
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Tag MName: |Risk Mitigation Description: | Treatment of Risk

Detail:
Type=Enum;

Walues=Avoidance, Reduction, Sharing, Retention;
Defautt=Reduction;

For example a date picker can be applied to allow a user to select the date a
Change was authorized.

Learn more about the

Tagged Values
Tagged Values
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Team Library

Getting to know Team Library

Introducing Team Library The Team Library provides an opportunity for developers, modelers, customers
and stakeholders to comment and provide feedback on the work in progress or at
the completion of a milestone or project.

Team Review B =

ﬁﬁ 2 | <Cumert Model= M ,'::' {@

+

E Deployment Issues
= [ Requirement Issues
= Shopping Cart facility
B [ Shopping Cart Button
= £ Model Links
REQ014 - Shopping Basket
& Use Case Model

Usage of Team Library The Team Library feature can be used to conduct model reviews from any number
of perspectives, including walk-throughs, formal model reviews, or ad-hoc
reviews.

Where to find Team To post or view an element's discussion
Library  Ribbon: Start > Collaborate > Team Library

Options for Team Library There is a wide range of settings available to configure the Team Library available
from the Category and Topic context menus, including setting the status of the
category or topic and other options. Diagrams, elements and element features can
be conveniently dragged from the Browser window to create model links that can
be used by team members to hyperlink directly from the Team Library window to
these items in the Browser window.
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= [ weekly Design Reviews
Thursday 20 June

New Document

MNew Document from Template
Rename (F2)

Copy Path To Clipboard

Share Resource 4

Refresh Topic ‘Thursday 20 June’

i

Reload Current Connection

Review Status 4 Awaiting Approval [:}
Mark 4 Approved

Bind to Project Erowser Package Rejected
Mane

Security Options 4

mm
AL

Connections...

Options...

Delete Topic Thursday 20 June’

Help...

Learn more about Team Team Library
Library
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Testing

Getting to know Testing

Introducing Testing Enterprise Architect has a number of tools that can be used for modeling aspects
of the test discipline. The Testing Window is the central tool for creating and
managing tests, allowing a range of different test types to be defined, including
properties such as Status and the results of tests to be recorded.
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e The Class of Test (such as Acceptance)
e  The Date it was last run

e Description of the Test

e Inputs required

e  Acceptance Criteria

e Results

Testing
Acceptance Tests - :ﬁ X G@

TestClass  Test Status Type Last Run Run By Checked By Description
Acceptance Five non contiguous titles selected Pass Acceptance 22/05/2018 Greg Nichols Paulene Dean This is to test the User Interface control to el
Acceptance Notitles selected Fail Standard 15/05/2015

Acceptance Twotitles selected one with nostock Deferred  Standard 15/05/2015

4 »
Construct - Acceptance Testing o x
=S-9HE X @

Testing -

Test Five non contiguous titles selected

Type Acceptance -

Run Date 22/05/2018

Result Pass

Run by Greg Nichols

Check by Paulene Dean

-

Description  Input Acceptance Criteria  Results

BJU&- 2= »*%@ [

This is to test the User Interface control to ensure that non-contiguous items can be selected and that the supporting technology services can process them.

Learn more about Testing Testing
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Traceability Window

Getting to Know the Traceability Window

Introducing the The Traceability window gives the modeler a hierarchical view of element
Traceability Window connections, allowing traceability to be visualized and queried as elements are
traversed in the model. This tool is particularly powerful because a modeler will
often choose to hide diagram relationships but by selecting an element in the
diagram and viewing its connections in the traceability window all its relationships
will be displayed.

Traceability X

d & @ @
= & Add To Shopping Basket
&= OWng
= --+ implements
REQ014 - Shopping Basket
Shopping Bashet
= === realized by
BrowseCatalogue
Shopping Basket
B 4= UseCase from
¢ Client
= -+ needed by
= %] BasketManager
= -+ nesded by
= &) Web Server
= @ composed of
= [E) 216.239.46.96
B 4= Association from
B HOESM

Where to find the Start > Desktop > Design > Traceability
Traceability Window

Usage of the Traceability The Traceability Window can be used to view the way an element is connected to
Window other elements in the repository, in a hierarchy including the type of each

relationship. This window gives a complete list of all relationships that cannot be
seen by viewing elements in the Browser window and that also might not appear
in any diagrams. It is very useful for managing requirements and tracing how a
requirement is related to up-process elements such as Business Drivers and
down-process elements such as Components. It is a useful tool for newcomers to a
model to gain a quick understanding of which are the important and well
connected elements. It should be viewed before deleting an element in the model
to ensure that the user understands the element's existing relationships.

Options for the There are a series of options that restrict the traceability to specified connector
Traceability Window types; these can be set to alter what is displayed in the window. The options are
available from the toolbar at the top of the window.
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Learn more about the
Traceability Window
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The Traceability Window
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Use Case Diagram

Getting to know the Use Case diagram

Introducing the Use Case The Use Case diagram is one of the Unified Modeling Language (UML)
Diagram Behavioral diagrams that can be used to describe the goals of the users and other
systems that interact with the system that is being modeled. They are used to
describe the functional requirements of a system, subsystem or entity and present a
simple but compelling picture of how the system will be used.

Online Bookstore O

Use Case diagrams can be created
showing the system as a Boundary
that contains the Use Cases. There is
a sophisticated editor that can be
used to detail the steps of scenarios
including constraints. A behavior
diagram can be automatically
generated from a scenario that
allows the steps described in the
scenario to be visualized.

nage Titles

Products Manager Chief Editor

ate Orders

On-line Customer

tock Levels i

Customer Support Officer

They are typically used in conjunction with higher level Business and Stakeholder
Requirements and are often supplemented with a set of Non Functional
Requirements.

Where to find the Use Ribbon: Design > Diagram > Add > UML Behavioral > Use Case

Case Diagram Browser window Toolbar : New Diagram icon > UML Behavioral > Use Case

Browser window context menu | Add Diagram... > UML Behavioral > Use Case

Usage of the Use Case The Use Case diagram is used to describe the goals that users or other systems
Diagram want to achieve from interacting with the system. They always describe the goal
from the Actors' perspective, the details of the Use Case will describe the goal
with more precision.

Use Cases will often act as the basis for the definition of Test Cases.
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Options for the Use Case
Diagram

Learn more about the Use
Case Diagram

Any number of Use Case diagrams can be created to represent different parts of a
system or Packages of Use Cases. The diagrams can be kept simple or they can be
structured by the application of a number of additional connectors such as Include,

Extend and Generalization relationships.

A system Boundary can be included that is used to name the system, subsystem or
entity under discussion; the Actors lie outside the Boundary and the Use Cases

inside.
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Use Case diagrams can be used to show how the Use Case are related to other
elements in the system, including up-stream elements such as Requirements and

down-stream elements such as Components.

The Use Case diagram (as for any diagram) can be viewed as an Element List,
which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams, to draw attention
to parts of the diagrams and the diagrams can be presented as hand drawn or in a
whiteboard style by changing the properties of the diagram.

Use Case Diagram
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Introducing Use Case
Estimation

Where to find Use Case
Estimation

Usage of Use Case
Estimation

Options for Use Case
Estimation

(c) Sparx Systems 2019

Use Case Estimation is a comprehensive project estimation tool that is used to
calculate effort using Use Case and Actor elements. The complexity of the work
environment is set using a series of weighted Technical and Environmental
Complexity factors and Use Cases and Actors are given a rating that assigns their
complexity as Easy, Medium or Complex. The method is based on Karner's Use
Case Points Method, and allows a metrics report containing the project estimation
analysis to be produced and incorporated into project documentation.

QA Reports - Use Case Metrics

v x
QA Reports x 4 F
M 4 » M | Use Case Metrics * Testing Details Maintenance Details Dependency Details Implementation Details

Use Cases

Technical Complexity Factor

bl iec S iict =il xy Reload Unadiusted TCF Value (UTV): 47
Phase like * Bookmarked: | All - TCF Weight Factor (TWF): 0.01
p—— . 6 Include TCF Constant (TC): 0.6
Keyword like Use Cases: 0 Actors
Package Name Type Complexity Phaze TCF =TC + (TWFx UTV): 107
Manage Inventory  Manage Titles UseCase 5 1.0
Manage Inventory  Manage Publishers  UseCase 10 2.0 Environment Complexity Factor
Manage Inventory  List Stock Levels UseCase 10 3.0 Unadiusted ECF Value (UEV): 215
Manage Inventory  Edit Titles UseCase § 1.0
Manage Inventory  Create Orders UseCase 15 10 ECF Weight Factor (EWF): -0.03
Manage Inventory  Add New Titles UseCase 5 1.0 ECF Constant (EC): 14
ECF =EC + (EWFx UEV): 0.755
Unadjusted Use Case Points (UUCP) = Sum of Complexity 50 G:: E‘g:: per Easy: 40 Med: 80 Diff: 120
Total Estimate
Use Case Points (UCP) = UUCP * TCF * ECF = s+ 107 =+ 0755 = 40 uce
Estimated Work Effort hours) = 10 - 40 = 400 Hours
Estimated Cost = EWE * Default hourly Rate = 400 - 40 = 16000 Cost
BeCalculate Report View Report Default Rate Help

Ribbon: Configure > Reference Data > Model Types > Estimation Factors

Use Case Estimation can be used to calculate the required effort to complete an
initiative or part of an initiative.

Environmental and Technical complexity factors can be defined and given weights

and values that determine how they influence the effort that is calculated for an
initiative.

Page 138 of 153 Created with Enterprise Architect



Business Analysis Tools - Business Analysis Tools 20 January, 2020

Technical Complexity Factor

Unadjusted TCF Value (UTWV): 47

TCF Weight Factar (TWF): 0.01
TCF Constant (TC): 0.6
TCF =TC = (TWF x UTV): 1.07
Environment Complexity Factor

Unadjusted ECF Value (UEV):  21.5
ECF Weight Factor (EWF): 40,03
ECF Constant (EC): 1.4

ECF =EC + (EWFx UEV): 0.755

A value can be assigned to the phase property of one or more Use Cases; this
value can be used subsequently as the criteria of a filter to restrict the estimates to
just that phase. The estimate can also be filtered based on a Tagged Value set on
the Use Cases such as Criticality.

Learn more about Use Use Case Estimation
Case Estimation
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User Story

Getting to know the User Story

Introducing the User Story User Stories are most often associated with iterative processes and were originally
defined by Extreme Programming techniques. They are now more commonly
associated with a number of Agile processes. A User Story typically consists of a
simple statement made in a few short sentences describing what the user does or
needs to do to achieve a goal and why the goal is important to them. They are
typically written to replace detailed traditional requirements and allow developers
to understand the goals of a user and what their job functions entail.
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Business Analysis with user stories modeled in Sparx
Systems Enterprise Architect

This diagram shows how a User Story can be modeled
using a stereotyped Use Case. This allows the User
Story to be described and to show the connection to a
Persona. As a Sprint is being defined detailed
Requirements can be developed just-in-time for the
development work to begin.

Where to find the User Toolbox Page: Artifacts | User Story
Story

Usage of the User Story User Stories are useful as an alternative way of describing user requirements. They
are used as part of certain Agile processes, to provide a simple but clear
description of what the user does or needs to do as part of the role they perform.
They also typically describe the reason behind the goal the user wants to achieve.
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Options for the User Story A User Story can be created using the stereotyped Artifact available from the
'Artifact’ Toolbox page or as a stereotyped Use Case. While many proponents of
User Stories see them differently to Use Cases, they are both aimed at defining a
goal that a user in a role wants to achieve. A stereotyped Use Case can also be
used to represent a User Story with just the description written in the form: 'As a
(Stock Controller) I want to be able to... ". They can be defined in conjunction with
Personas that help to allow analysts to empathize with the users.

Toolbox O x

Mare toals...

Common
= Artifacts

Artifact

Document

Checklist

User Story

Waorking Set

Standard Chart

Time Series Chart

Maodel Wiew

Report Specification
Matrix Specification
Executable StateMachine
Business Process Simulation
BP5Sim Result Chart

BPSim Custom Result Chart

T T 1 TP PP I P

Learn more about the User Story
User Story
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Value Chain

Getting to know the Value Chain

Introducing the Value The Value Chain is a strategic diagram that allows the primary and secondary
Chain activities in an organization to be modeled. The diagram can be created from a
Pattern that adds and connects the five primary activities in a chain and the four
supporting activities underpinning them.

Firm Infrastructure

Human Resource Management

Technology Development

Procurement
Inbound I Outbound Marketing & i
i Operations e Service
Logistics Logistics Sales

Legend
[:] Gross Sales
D Support Activities
[:] Primary Activities

An analyst working at the strategic business unit level will often be asked to model
the activities the business unit performs to provide value to its customers. The
Value Chain is the preferred tool for creating this strategic representation of the
sequence of activities that an organization performs.

Where to find the Value Ribbon: Design > Diagram > Add > Strategic Modeling > Value Chain

Chain Browser window Toolbar : New Diagram icon > Strategic Modeling > Value
Chain
Browser window context menu | Add Diagram... > Strategic Modeling > Value
Chain

Usage of the Value Chain The Value Chain is an important tool to assist with strategic planning allowing the
whole sequence (or chain) to be understood. It also allows the chain to be broken
down into its constituent activities allowing the evaluation of costs, resource and
value to be determined and potentially improved.

(c) Sparx Systems 2019 Page 142 of 153 Created with Enterprise Architect



Business Analysis Tools - Business Analysis Tools 20 January, 2020

Options for the Value Each one of the Primary and Supporting Activities can be linked to other elements
Chain in the model including a Linked Document and elements that define benchmarks.

X

Toolbox O
Mare tools...

»

=l Value Chain

[T+ Gross Sales
= Primary Activity
[ support Activity
£l Patterns
¥3 Value Chain —

The Value Chain diagram (like any diagram) can be viewed as an element list
which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention
to parts of the diagrams.

Learn more about the Value Chain
Value Chain
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Visual Filters

Getting to know Visual Filters

Introducing the Visual
Filters

Where to find the Visual
Filters

Usage of the Visual Filters

(c) Sparx Systems 2019

Visual Filters provide a mechanism for filtering out parts of a diagram or list of
elements that are not of interest, leaving just the elements and connectors that are
relevant to the view. The filters can be defined for elements or connectors and
there is a wide range of criteria that can be set, such as filter out all elements that
don't have a status of 'Validated' and were created since a milestone date.

PG
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Manage Titles
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Model stakeholders typically have different interests and often only part of a
diagram or element list will be relevant to them. Visual filters can assist by
allowing you to filter out parts of a diagram or list of elements leaving just the
elements and connectors that they want to see. This is a powerful tool in
workshops, focus groups and meetings allowing a modeler to present a single
diagram in many different ways.

Ribbon: Layout > Tools > Filters and Layers

Visual Filters can be defined at a Repository level making them available to all
users. The application of the filter is however specific to the current user, so two
analysts could apply different filters to the same diagram or list simultaneously.
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Options for the Visual There are a number of options available from the Visual Filters Toolbar including
Filters being able to change the way the element obscuration is presented from: Fade,
Gray Scale, Hide and Select.

-\/

r 10 % | Fade T X @

Context filtering can be applied so that only the element selected in the diagram
and its directly connected elements will be enabled, this can be enabled from the
Visual Filters window Context Menu. The filtering effect can be to hide, fade or
gray scale the irrelevant elements; the Select option will conversely select the
elements of interest in the diagram or list.

Learn more about the Visual Filters
Visual Filters
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Wire Frame Diagram

Getting to know the Wire Frame Diagram

Introducing the Wire Wire Framing is a productive tool that can be used to create visually compelling
Frame Diagram and realistic models of commercially available phones, tablets, screens and web
pages. The diagrams assist Business Analysts, Experience Designers and others
communicate with stakeholders, allowing them to demonstrate the solution
interfaces.
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Management)
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This diagram shows the rich support for creating wireframe models of modern portable devices such
as cell (mobile) phones and tablets. The toolbox has rich support for a wide range of pre-built
controls applicable to the main types of devices in use including Apple and Android devices. Parts of
the interface can be linked to other elements in the repository creating powerful traceability.

Many stakeholders will understand how a solution is going to work if they can see
something concrete and visual. The Wire Framing tool is perfect for this situation
where a mock-up of the user interface of a phone, tablet or web page is created
including page layout, interface and navigational controls representing different
parts of a User Story or Use Case.

Where to find the Wire Ribbon: Design > Diagram > Add > Wireframing > Apple, Android, Dialog,
Frame Diagram Webpage, Windows Phone Wireframe

Browser window Toolbar : New Diagram icon > Wireframing > Apple, Android,
Dialog, Webpage, Windows Phone Wireframe

Browser window context menu | Add Diagram... > Wireframing > Apple,
Android, Dialog, Webpage, Windows Phone Wireframe
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Usage of the Wire Frame A Business Analyst or Experience Designer will typically create Wire Frame
Diagram models for the devices that are being targeted in the solution. The interface
elements and navigational controls can be connected to other elements in the
Repository. For example a drop down list could be connected to a data source
indicating the origin of the data. A slide show could also be created to walk a
stakeholder through a sequence of diagrams representing the flow through a User
Story or Use Case.

Options for the Wire There are built in toolboxes for the most common types of device, including:
Frame Diagram  ,  Apdroid Phones and Tablets
e Apple iPhones and Tablets
e  Windows Phones
e Screen Dialogs
e  Webpages

The toolboxes contain elements for the devices, pages and screens and a wide
range of controls, widgets and other elements. Tagged Values can be set to hide or
display elements of the interface such as phone menu buttons and notification
bars.
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Diagram Filters can also be used when presenting the diagrams to draw attention
to parts of the diagrams, and the diagrams can be presented as hand drawn or in a
whiteboard style by changing the properties of the diagram.

Learn more about the Wire Framing
Wire Frame Diagram
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Working Sets

Getting to know Working Sets

Introducing Working Sets Working Sets are a powerful way of saving a group of Workspace items such as
diagrams and matrices so they can be re-opened as a set at a later time. This allows
a modeler to switch between multiple tasks without losing the context of the items
they are working on.

Model Views O x

B BRI EEEES 2 X@
B g Working Sets
= [z Stakeholder Workshop Preparation
Run the search 'Recently Discussed Elements’
B2 Open the matrix profile 'Evaluation Criteria x Solution Options - CRM'
o Requirement Business Rule Traces
Ba Policies and Business Rules
Fa Issues
Ba UserInterface Prototype
Open document template 'Phase3 Regirements’
5 Business Model Canvas
z] Custormer Field Length Investigation

A Business Analyst will often work on a number of tasks simultaneously and each
task will typically require the application of a number of techniques and tools
including diagrams, matrices, documents and more. Working Sets allow a user to
save groups of windows and diagrams they are working on as a set, giving the
group a name so it can be easily recalled and the items opened as a set at a later
time.

Where to find Working Ribbon: Start > Desktop > Working Sets
Sets

Usage of Working Sets Working Sets can be used to store a group of items open in an Enterprise Architect
workspace as a set that can be reopened at a later time. A typical scenario is that a
Business Analyst is working on a particular task and has a number of relevant
diagrams and matrices and documents open that define parts of a problem or
solution for a particular initiative. Suddenly they receive an urgent request to
complete an unrelated task. They could save the open items as a Working Set so
that once the urgent matter had been attended to the group of items could be easily
reopened.

Options for Working Sets Working Sets allow a number of different items to be added to a set including:
e Diagrams
e  Matrix Profiles
e Searches
e Team Library
e  Document Templates

e Resource Documents
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Any number of each type of item can be added to a Working Set and the contents
of the set can be edited and diagrams can be located in the Browser window.

Open Waorking Set

Create Working Set...
Create Working Set From 4

Edit
Copy as New

Share Waorking Set

Apply when Model opens
Store Main Tab View History
Refresh Warking Set Items

Delete Working Set Item
l@' Help
There are a range of options available from the "Working Set <name>' context

menu including being able to make the working set available to other model users
by choosing the 'Share' option.

Learn more about Working Sets
Working Sets
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XML Schema Generation and Import

Getting to know XML Schema Generation and Import

Introducing XML Schema
Generation and Import

The XML Schema Generation and Import is a built-in facility to model, forward
engineer and reverse engineer XML Schemas. XML Schema Definition (XSD),
also known as XML Schema, is a World Wide Web Consortium (W3C) XML
technology and is used in a wide range of industries to encourage standards
compliance and messaging using a common schema. The XSD specifies the rules
to which an XML document must adhere and can be automatically validated by a
number of tools.
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modelGroup = all + surblame: string
tags
mambariamas =

mixed = false
maodelGroup = all

«XSDcomplexTypes string

Employee
«XSDchoicas

PhoneCheoice

= zXSDelements

* |+ deparment: strng
+ jobTitle: string

+ stardDate: dste

mobilePhone: string
officePhone: strng

string cenumearations
«XSDsimpleTypes Status
Gender

Attributes

Full-Time: string
Part-Time: sting
Casusl string
Contract: strng

tags
derivation = restriction
pattem = male|female

Where to find XML Export XSD

Schema Generation and
Import

Ribbon: Develop > Schema Modeling > Import XSD  or

The XML Schema Generation and Import facility can be used to visualize or
create a model of an XML Schema (XSD). This is particularly useful when the
repository is describing shared messages or a schema that is based on a standard.

Usage of XML Schema
Generation and Import

An XML Schema can be created using an in-built model transformation applied to
an abstract Class diagram or it can be modeled using the XML Schema Toolbox
page using a Class diagram. Either way the completed schema model can be
generated to create an XSD file using names and details specified in the Tagged
Values of the Schema Package. There is also a purpose built tool for working with
schemas called the Schema Composer, which allows messages to be created based
on part of a schema.

Options for XML Schema
Generation and Import
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Learn more about XML XSD Models
Schema Generation and
Import
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http://www.sparxsystems.com/enterprise_architect_user_guide/15.1/model_domains/xml_schema_xsd.html
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